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Chapter 1. Introduction
1.1 GENERAL INFORMATION
This Quick Start Guide is intended to be used by all people that operate the Epsilon 3 
spectrometer together with Epsilon 3 software version 1 (or higher). It provides full 
details of how to operate the spectrometer system.

This Quick Start Guide is not intended to provide you with details of maintenance 
procedures that should be carried out by trained and qualified engineers. Nor is it 
intended to act as a User’s Guide for MS Windows. You should refer to the 
documentation and on-line tutorials provided with these products.

1.2 INTENDED USE
The Epsilon 3 spectrometer and the Epsilon 3 application software are designed to 
perform routine X-ray measurements over a long period of time. For example, you 
can use it to calibrate the instrument to measure the amount (or ratio to another 
element) of Ni in oil and then use the system to carry out that task over a number of 
months.

It is expected that the system will mostly be used by laboratory or factory personnel. 
One person will set up the system (for example calibrate the system for a particular 
application using standards) and then password protect the various system 
parameters etc. This would enable other laboratory personnel to use the system to 
measure samples but not to change (either by accident or on purpose) the setup or 
system information.

1.2.1 System
The system facilities (selected via the menu bar or toolbar) are used to create 
‘common’ items that may be used in several applications or by several users (for 
example system condition sets, system moduli and so on). You can then use one or 
more of these system items (for example a condition set) when setting up an 
application in order to prevent having to enter the information over and over again. 
For example: if you know that the system is going to be used regularly for measuring 
oil samples, you can create a system condition set called “oil”. Then, when you 
create an application for measuring oil you could just enter “oil” as the condition set 
name without having to remake the entire condition set.
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1.3 CONVENTIONS USED
◆ An instruction is preceded by a bullet “ ”.

◆ Menu items, keys and pushbuttons on a window are shown in bold text, for 
example: File > Open, Enter, Ctrl, Apply, Cancel.

◆ Grids are table-like areas on windows used to input and display large 
amounts of information.

◆ There may be differences between the example screens given in this Quick 
Start Guide and what you see on your screen. In all cases, where there is a 
difference, follow what you see on your screen.
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Chapter 2. Software User Interface
2.1 EPSILON 3 SOFTWARE MAIN WINDOW
When the Epsilon 3 software is started (see Chapter 3), the Epsilon 3 Software 
main window is opened.

Figure 2.1    Epsilon 3 Software Main Window

The following elements are displayed in the main window:

At the top of the screen:

◆ Menu bar

◆ Toolbar

◆ Spectrometer status bar
NOTE: The spectrometer status bar is only displayed if it is enabled 

and the spectrometer is on-line.

At the bottom of the screen:

◆ Last result window

◆ Online status or Offline status window 

◆ Messages window

◆ Progress window (only when system is on-line)
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2.1.1 Menu Bar

The menu bar is displayed directly under the title bar in the Epsilon 3 Software 
main window. The menu bar displays a list of the menus available in the Epsilon 3 
software. Most of the commands and functions of the Epsilon 3 software can be 
selected from the menus.

Menus or menu items that are not currently available are shown in light grey and 
cannot be selected.

NOTE: When the hardware is not on-line, the test menu is unavailable (light 
grey).

Table 2-1 Menus

Menu Description

System This menu gives access to the system management windows, 
Epsilon 3 Software main window options (for example: Toolbar 
displayed?), communications setup and logging, printing, and 
exiting.

Edit This menu allows you to copy, paste or print selected text, spectra 
or graphs to and from the clipboard. With the Select All menu item, 
you can select the whole text or graphics in the active form.

Application This menu allows you to open, close, display or delete existing 
applications and to create new applications.

Measure This menu allows you to open, close or display the measure 
window for an application.

Results This menu allows you to open, close or display the results window 
for an application.

SPC This menu allows you to open, close or display the SPC values 
windows for an application.
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2.1.2 Toolbar

The toolbar provides a fast user-friendly way to access some of the commonly used 
commands. The toolbar is displayed by default when the software is first started, but 
can be turned off from the System menu.

The current PC system date and time are displayed on the right of the toolbar.

NOTE: The role of some of the buttons changes depending on whether function 
windows for that button are already open in the application window. 

Omnian Setup This menu allows you to set up Omnian sample parameters, 
calibration, standards and compound lists for measuring unknown 
samples using the Omnian optional software.

Window This menu offers the usual Windows options for arranging the 
windows within the Epsilon 3 Software main window. It also 
offers a list of all open windows allowing you to select and activate 
the required window.

Test This menu allows you to manually control and test the 
spectrometer.

Help This menu allows you to access the Epsilon 3 On-line Help facility.

Table 2-2 Toolbar Buttons

Button Description

Displays the Messages window.

Displays the spectrometer Offline status window.

Table 2-1 Menus (Continued)

Menu Description
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Displays the Last result window.

Displays the Manual control window.

Moves the sample changer to the reference position.

Displays the Sample changer window.

Displays the System parameters window. See NOTE.

Displays the System condition sets window. See NOTE.

Displays the System moduli functions window. See NOTE.

Displays the System compound definitions window. See NOTE.

Opens an application or displays the Open application window. 

Opens a measurement or displays the Measure application window. 

Opens results or displays the Open results window. 

Opens SPC values or displays the Open SPC values window. 

Table 2-2 Toolbar Buttons (Continued)

Button Description
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NOTE: If this window is already open, it is displayed at the front and made 
active.

2.1.3 Status Bar

Figure 2.2    Status Bar

If the spectrometer is on-line, the status bar is displayed by default when the 
software is first started. It can be turned off from the System menu.

This bar contains a number of information fields describing the status of the 
spectrometer. These fields cannot be edited.

Starts an Easy measure, for applications that have an already opened 
Measure application window. 

Opens the Epsilon 3 On-line Help.

Table 2-3 Spectrometer Status Bar Fields

Status Bar Field Description

Lid: Status of the spectrometer lid: “Open” or “Closed”.

Ap: (Application) Active application during a measurement.

Spin: (Spinner) Status of the spinner: “On” of “Off”. Only shown when spinner 
is present.

Sq: (Sequence) Current sequence number.

T: (Time) This menu allows you to open, close or display the results 
window for an application.

Pos: (Position) Position of the sample in the sample changer.

Table 2-2 Toolbar Buttons (Continued)

Button Description
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2.2 APPLICATION WINDOW
Each application window contains a form used for configuring, entering data, 
carrying out measurements or processing results.

Up to 8 application windows can be opened or minimized, at any time within the 
Epsilon 3 Software main window. A further limit is imposed by the system 
resources: if resources drop below 10 %, the software will prevent you to open any 
further windows until you have closed some others.

The windows use a wide variety of controls and fields to display information, 
control the operation of the software and navigate around the other windows.

The application window has four areas:

◆ Sample definition information

◆ Channel information

◆ Navigation/control

◆ Additional information

The next sections describe the control and navigation buttons of the navigation/
control area and of the channel information area. For information regarding the 
other items and areas, see Chapter 4.

Cond: (Condition) The name of the current condition set.

T: (Time) Time remaining for the current condition.

Table 2-3 Spectrometer Status Bar Fields (Continued)

Status Bar Field Description
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Figure 2.3    Typical Application Window
Page 2 - 9



Epsilon 3 Quick Start Guide
2.2.1 General Control Buttons
The the navigation/control area contains general control buttons, used to save or 
cancel any changes made in the window and to close the window.

2.2.2 Grid Control Buttons
The channel information area contains a number of grid control buttons, normally 
displayed with the grids.

In addition, control buttons that only provide functions for a particular grid may be 
displayed. These additional control buttons are described when occurring in the 
following chapters. 

Table 2-4 General Control Buttons

Button Description

Saves changed values and closes the window.

Saves changed values but does not close the window.

Closes the window without saving.

Resets changes values to the original value.

Table 2-5 Grid Control Buttons

Button Description

Resizes the cells in the grid so that each column displays the longest entry.

Prints the active window.

Adds a new item. Inserts the new item you have entered in the input field 
into the grid.
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2.2.3 Navigation Buttons
The center of the navigation/control area contains of a number of navigation 
buttons, which are used to open or move to other windows for that application.

The buttons displayed in this area are the same on all the application windows.

Deletes the selected item(s) from the grid.

Changes the password for this application.

Restores the edited value to the value that was last saved or transferred to 
the grid.

Saves the edited value to the selected grid position.

Table 2-6 Navigation Buttons

Button Description

Opens the application window.

Opens the ident system window.

Opens the recalibration program window.

Opens the calculation program window.

Table 2-5 Grid Control Buttons (Continued)

Button Description
Page 2 - 11



Epsilon 3 Quick Start Guide
Opens the standards window.

Opens the SPC setup window.

Opens the condition sets window.

Opens the moduli functions window.

Opens the compound definitions window.

The functions provided by the lower three buttons can still be used (via the toolbar) even 
if the application is protected by a password.

Opens the measure sample window.

Opens the results window.

Opens the SPC values window.

Table 2-6 Navigation Buttons (Continued)

Button Description
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2.3 GENERAL USER ACTIONS

2.3.1 Resizing Grid Cells
When information is displayed in a grid, the size of the grid cells can be adjusted 
either manually or automatically.

To adjust the size of the cells manually:

• Use the mouse in the column or row title to drag the selected columns or 
rows.

To adjust the size of the cells automatically:

• Click on the  button. This automatically resizes the column widths 
and cell heights to fit the data in the grid.

2.3.2 Adding and Deleting Rows
If a selected row field and add/delete buttons are displayed above the grid, you can 
add and delete rows from the grid.

Figure 2.4    Typical Add/Delete Grid Area

The selected row field normally shows the row containing the selected cell. If 
multiple rows are selected (for example: a complete column) the field is filled with 
“xxxx”.

To add a new row:

• Click in the relevant text field (in this case the Channel field) to insert the 
text cursor.

• Enter the name of the row to be added.

• Click on the  button or press the Enter key to insert the new row.
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To delete a row:

• Select the row to be deleted by clicking on the row title. The title is shown 
in the selected row field.

• Click on the  button.
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Chapter 3. Configuring the Epsilon 3 Software
3.1 INTRODUCTION
Viewing and changing the system parameters and default definitions is carried out 
in System Mode, via the following windows:

◆ System parameters window

◆ System conditions sets window

◆ System moduli functions window

◆ System compound definitions window

Each of these windows can be accessed by clicking on their respective toolbar 
buttons or by selecting the item from the System menu. If a system manager 
password has been set and the system is in User Mode, the password must be entered 
in the window before any of these windows will open.

3.2 CONFIGURING THE SYSTEM PARAMETERS
The System parameters window is used to view and allow changing some system 
parameters. It displays the following system parameters:

◆ X-ray tube parameters

◆ Filter parameters

◆ Conversion factors

◆ He system

◆ Transmission of results

The System parameters window also allows you to set and change the system 
manager password and set the printer font and size.

To open the System parameters window:

• Click on the  button or select System > System parameters.

If a system manager’s password has been set, a window is displayed 
requesting the system manager’s password.

• Type the password and click on the OK button or press Enter to open the 
System parameters window.
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Figure 3.1    System Parameters Window

3.2.1 Setting or Changing the System Manager 
Password

If no system password is set, any password set in the application is disabled. Also, 
if the system password is deleted (no new password is defined), the application 
passwords are disabled. In both of these instances, any application password set is 
stored by the software and is automatically enabled when a new system password is 
set.

To set the system managers password

• In the System parameters window, click on the  button. The Set new 
password for system manager window is displayed.
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Figure 3.2    Set New Password for System Manager Window

• In the New password field, enter the password. A “*” is displayed for 
each character as it is typed.
NOTE: The passwords are NOT case sensitive.

• Enter the password again in the Verification field.

• Click on the OK button or press Enter.

To change the system managers password

• In the System parameters window, click on the  button. The Set new 
password for system manager window is displayed.

Figure 3.3    Set New Password for System Manager Window

• In the Current password field, enter the existing password.

• In the New password field, enter the new password.

• Enter the new password again in the Verification field.

• Click on the OK button or press Enter.
Page 3 - 5



Epsilon 3 Quick Start Guide
3.2.2 Viewing the X-ray Tube Parameters
In on-line mode, the X-ray tube parameters are displayed in the System parameters 
window as light grey fields and cannot be changed. Some of the X-ray tube 
parameters are read from the spectrometer firmware.

NOTE: In off-line mode, the X-ray tube parameters can be changed. However, 
the correct settings are restored when you go on-line to the 
spectrometer.

3.2.3 Enabling the Helium System
• Check the Helium check box to enable helium to be used in the 

applications.

Table 3-1 X-ray Tube Parameters

Parameter Description

Anode element X-ray tube anode material.

Window (um) The thickness of the beryllium window of the X-ray tube.

Max mW The maximum allowed power that can be applied to the X-ray 
tube (9000 W/15000 W).

Max kV The maximum allowed voltage that can be applied to the X-ray 
tube (30.00 kV/50.00 kV).

Max uA The maximum allowed current that can be applied to the X-ray 
tube (1000 µA/3000 µA).

Window (um) The thickness of the X-ray tube’s beryllium window.
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3.2.4 Setting the Printer Parameters
The fields Printer font name and Size in the System parameters window allow 
you to set the printer font type and size (in points).

We do not recommend using font sizes below 8 points, as many people find this 
difficult to read.

The page setup for the default printer (paper size, landscape or portrait, etc.) is 
defined in the printer setup, which can be accessed from the System menu.

Graphical windows are always printed in landscape and fitted to the maximum 
printable size on the page.

3.2.5 Viewing the Filter Parameters
Table 3-2 shows the filters fitted to the system. For more information about the use 
of filters and their effect, see Chapter 13

3.2.6 Enabling Transmission of Results
It is possible to enable the transmission of the measurement results to a folder on 
your hard drive. The folder must be an existing folder on your hard drive. The 
measurement results can be used by other applications for further processing.

Table 3-2 Filters

Filter number All X-ray Tubes Thickness (µm)

1 Cu-500 500

2 Ti 7

3 Al-50 50

4 Al-200 200

5 Cu-300 300

6 Ag 100

7 none -
Page 3 - 7



Epsilon 3 Quick Start Guide
The transmitted files have the following file name format:

XYYYYMMDDHHMMSS.QAN

where: X is fixed
YYYYMMDDHHMMSS is the year (YYYY), month (MM), day (DD),
hour (HH), minutes (MM) and seconds (SS).

Transmission can be carried out both on-line or off-line.

• In the System parameters window, check the Enabled check box to 
enable transmission for an application.

• The measurement results of the specified application will be transmitted 
on-line depending on the application setting (Yes, No or Ask).

• The Transmit check box on the Measure sample window is set according 
the System parameters window setting.

• On the results window, you can transmit the highlighted samples off-line 

using the  button.

Only the data from unknown samples, concentration and/or intensities are 
transmitted. Spectra and standard data are not transmitted.

3.2.7 Setting the General Parameters
This section describes the following two general parameters which are useful for 
operating the Epsilon 3 software:

◆ Backup user data

◆ Select language

To backup user data:
We advise you to make several copies of your data to protect it from accidental loss 
or hardware and media failures. Keep at least one copy off-site in a secure location 
at all times.

• Select System > Backup userdata to open the Backup userdata window.
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Figure 3.4    Backup Userdata Window

• Backup all user data that is new or updated in the source folder 
\PANalytical\Epsilon 3\Userdata. Select an existing destination folder 
and click on the Backup button to start the backup.

With each backup a new sub-folder is created in the destination folder with the 
following format:

YYYYMMDDHHMMSS 

where:  the format of the year (YYYY), month (MM), day (DD), hour (HH),
 minutes (MM) and seconds (SS) is used.

All files and sub-folders of the source folder are copied into the new destination sub-
folder with the actual format.

The source folder and destination folder only have to be specified initially and are 
shown each time when the Backup userdata window is opened.

To select a language:

• The Epsilon 3 software is default delivered in the English language.

• To select a local language, select System > Select language. The Select 
language window is displayed.
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Figure 3.5    Epsilon 3 - Select Language Window

The following local languages are available: 

• Select the required language and click on OK. The selected language will 
be changed after restarting the Epsilon 3 software.

3.3 SETTING THE SYSTEM CONDITIONS
The System condition sets window is used to create condition sets that can be used 
in all applications.

The software automatically selects predefined conditions when selecting elements 
to be measured.

To open the System condition sets window:

• Click on the  toolbar button or select System > System Condition 
sets. If a system password has been set, a window requesting the system 
manager’s password is displayed (unless another system window is 
already open, in which case you will not be asked for the password again).

• Type the password and click on the OK button or press Enter to display 
the System condition sets window.

◆ Chinese ◆ Italian ◆ Portuguese

◆ English ◆ Japanese ◆ Russian

◆ French ◆ Polish ◆ Spanish

◆ German
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Figure 3.6    System Condition Sets Window

To add other measurement conditions for specific applications:

• In the Condition set field, give the condition set a name.

• Enter the required kV, uA and Filter name.

• If the helium system has been enabled, you must also choose between Air 
and Helium as the measuring medium.

3.4 DEFINING SYSTEM MODULI
System moduli are “standard” factors (calculation functions) that are of relevance to 
the type of measurement that your system will be used for. They are included into 
an application as a channel (with an asterisk as a last character). You can set the 
moduli for ratios, sums or a combination of both. The system then checks the 
measurement results and reports on these channels.

For example:

If you wanted to know what the ratio of Al to Si is in your result, you press , 
enter a channel name and then the moduli Al/Si.
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As previously stated, the moduli are used to define calculation functions in the 
results of applications.

The moduli defined at system level can be used in all applications.

NOTE: Additional moduli can be defined in an application, but they are only 
available to that application.

For example:
To find the total concentration of halogens in a sample, you would define a moduli 
in which the values of all the halogen channels (Cl, Br, etc.) were added together.

Moduli: Ha*

Expression: Cl + Br

This moduli could then be entered as a channel in an application.

NOTE: Moduli names are one or two characters long with an asterisk (*) as the 
last character.

If the system is in User Mode and a system manager’s password has been set, a 
dialog box requesting the system manager’s password is displayed.

To open the System moduli functions window:

• Click on the  toolbar button, or select the System > System moduli.

Figure 3.7    System Moduli Functions Window
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To define a moduli:

• In the Moduli name field, enter the name for the moduli.

• In the definition field, enter the mathematical definition (valid expressions 
are: +, -, *, / and ^ (^ = “to the power of”)).

• Click on the  button. The name of the moduli appears in the Moduli 
list field, with the moduli definition directly opposite in the definition 
field.

To edit a moduli definition:

• Enter the name of the required moduli in the Moduli name field or click 
on the required moduli in the Moduli list field.

• In the definition field, edit the moduli definition as required. The new 
value is automatically inserted into the grid.

To delete a moduli definition:

• Enter the name of the required moduli in the Moduli name field or click 
on the required moduli in the Moduli list field.

• Click on the  button or press the Delete key.

3.5 DEFINING SYSTEM COMPOUNDS
This function allows you to prepare a list of compound definitions that are available 
for all applications and for manual spectrometer operation. You must enter a name 
and the chemical formula for each compound. The defined compound name and 
formulas are displayed in the grid in alphabetical order.

The compound name defined can be used as a parameter in applications and can also 
be set as the name reported after completion of an analysis.

If a system password has been set, a window requesting the system manager’s 
password is displayed.
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To open the System compound definitions window:

• Click on the  toolbar button, or select the System > System 
compound definitions.

Figure 3.8    Compound Definitions Window

To define a new compound:

• In the Compound field, enter the name of the compound.

NOTE: The input is case sensitive. Use the correct abbreviations for the 
chemical elements (for example aluminum = Al).

• In the Chemical formula field, enter the chemical formula of the 
compound.

• Click on the  button. The name of the compound and the chemical 

formula are automatically inserted into the grid.
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To edit a compound definition:

• Enter the name of the required compound in the Compound field or click 
anywhere in the definition field. The compound name and formula are 
displayed in the corresponding fields.

• Edit the compound definition as required. The new value is automatically 
inserted into the grid.

To delete a moduli definition:

• Enter the name of the required compound in the Compound field or click 
anywhere in the definition field. The compound name and formula are 
displayed in the corresponding fields.

• Click on the  button or press the Delete key.
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Chapter 4. Applications
4.1 INTRODUCTION
An application contains all the information necessary to perform a measurement. In 
normal use applications are set up by a specialist and the measurements are done by 
the operator. The application concept meets the requirements for pre-configured 
analysis procedures, allowing you to define a unique set of specifications for each 
application.

Every application can make use of the system configuration sets, moduli and 
compound definitions. Additional configuration sets, moduli and compounds can be 
defined for each application. These dedicated definitions can only be used within 
that application and take priority over any System level definitions with the same 
name.

Each application can be password protected. This prevents unauthorized users from 
opening or deleting an application or from closing an application measurement 
window.

A password protected application can still be copied with a new name. The copied 
application can then be opened, changed, etc. without the password.

4.2 HANDLING APPLICATIONS
Applications that are already defined can be opened, viewed, closed and deleted 
from the Application menu. An application can also be opened or viewed via a 
toolbar button. The role of this toolbar button varies, depending on whether other 
applications are already open.

Figure 4.1    Application Menu

If no applications are currently open, the items Select open application and Close 
application are not available (greyed-out).

Applications can be password protected. If a password has been set (and the system 
password is set), the application password must be entered before the application 
window can be opened. You can copy the application, but cannot alter the data in 
the original without the password.
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4.2.1 Opening an Application
To open an application from the menu bar:

• Select Application > Open application. The Open application window 
is displayed.

Figure 4.2    Open Application Window

• Select the required application and click on the OK button or press Enter. 
If no password was set, the selected application window is displayed.

• If a password was set, the Enter password for application window is 
displayed.

• Enter the password. A “*” is displayed for each character typed.

• Click on the OK button or press Enter.

• The selected application window is displayed.

To open an application from the toolbar:

• Click on the  button. If no applications are currently open, the Open 
application window is displayed. Otherwise, select which application to 
open, see Section 4.2.2.
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4.2.2 Selecting an Open Application
• Select Application > Select open application.

• If one application is already open, that application window is made the 
active window and displayed on top.

• If more than one applications are already open, the Select open 
application window is displayed.

Figure 4.3    Select Open Application Window

• Select the required application and click on the OK button or press Enter. 
If no password was set, the selected application window is displayed.

• If a password was set, the Enter password for application window is 
displayed.

• Type the password into the text input field. A “*” is displayed for each 
character typed.

• Click on the OK button or press Enter.

• The selected application window is displayed.
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4.2.3 Closing an Application
When the application window is closed, any other open definition windows for that 
application are closed automatically, including the following windows:

◆ ident system window

◆ moduli functions window

◆ compound definitions window

◆ standards window

◆ calculation program window

◆ SPC setup window

A prompt is displayed for each window that will be closed with unsaved changes.

To close an application from the application window:

• In the navigation/control area of the application window, click on the OK 
button to save all current settings and data and close the window or click 
on the Cancel button to close the window without saving any changes.

To close an application from the menu bar:

• Select Application > Close application. The Close application window 
is displayed.

Figure 4.4    Close Application Window

• Select the application to close and click on the OK button or press Enter.
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4.2.4 Deleting an Application
Deleting an application deletes all the data related to that application.

• Select Application > Delete application. The Delete application window 
is displayed.

Figure 4.5    Delete Application Window

• If a password was set, the Enter password for application window is 
displayed.

• Enter the password. A “*” is displayed for each character typed.

• Click on the OK button or press Enter.

• A warning is displayed for confirmation.

 

Figure 4.6    Delete Warning Window

• Click on the OK button to delete the application.
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4.3 DEFINING A NEW APPLICATION
To assemble a new application, you must define certain parameters and carry out a 
calibration. Additionally, a number of other parameters and actions can be defined.

This section describes the minimum steps you must perform to define an 
application. 

The following steps MUST be performed in the following order to define an 
application:

1. Assemble the analytical program by:
a. Creating a new application (Section 4.3.1).
b. Defining the sample type (Section 4.3.2).
c. Selecting channels (elements to be measured) (Section 4.3.3).
d. Setting the channel parameters (Section 4.3.4).

2. Calibrate the application by:
a. Entering the composition data of the standard samples (Section 4.4.1).
b. Finding and calculating the line grouping (Section 4.4.2).
c. Measuring the standard samples (Section 4.4.3).
d. Performing deconvolution (Section 4.4.4).
e. Calculating the regression lines (Section 4.4.5).
f. Displaying the calibration results (Section 4.4.6).

3. Additionally, other parameters and actions may be needed, such as:
a. Transmitting results (Section 4.3.5)
b. Display and printing results (Section 4.3.6)
c. Optimizing conditions (Section 4.3.7)
d. Setting an application password (Section 4.3.8)
e. Identifying material by FingerPrinting (Section 4.3.9)
f. Automatic sample identification fields (Section 4.5)
g. Application moduli definitions (Section 4.5)
h. Application compound definitions (Section 4.5)
i. Statistical Process Control (SPC)
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4.3.1 Creating a New Application
You can create an application either entirely from new or by copying and modifying 
an existing application.

NOTE: No password is required to copy an application; as this does not affect 
the original application.

To create a new application:

• Select Application > New application. The New application window is 
displayed.

Figure 4.7    New Application Window

• In the New application field, enter a name for the new application.

• Click on the Create New button. An application window is displayed 
with the new name.
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To create a new application from an existing application:

• In the New application field, enter a name for the new application.

• Select the name of the application to be copied from the Existing 
applications list.

• When the results of the existing application are also required for the new 
application, check the Copy results check box.

• Click on the Copy Old button.

• An application window is displayed with the new name. The window will 
contain all the settings from the copied application, except the password 
and the results.

Figure 4.8    Application Window
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4.3.2 Defining the Sample Type
You must define the sample type and give the required preparation information to 
enable the software to process the results correctly.

Parameters and information that must be entered depend on the selected sample 
type. For example, flux information is only needed for a fused bead sample.

After you have defined your sample type and sample preparation data, you must 
save it before proceeding any further.

4.3.2.1 Normalise to 100% and Balance

The Normalise to 100% and Balance check boxes are offered for all sample types.

4.3.2.2 Metal/Alloy Samples

This type of sample covers solid samples prepared without any additives, for 
example: solid metal or plastic samples.

Normalise 
to 100%:

When a sample is analyzed, the sum of the calculated concentrations 
should be 100 %. In practice, the sum is likely to be slightly different 
than 100 %. Normalization is the recalculation of results in such a way 
that the sum of the concentrations is equal to 100 %.
In general, the accuracy of the results is improved using normalization 
when the main component comprises over 60 % of the total sample.

Balance: If Balance is checked, the concentration of the balance compound will be 
calculated as 100 % minus the sum of all the other compounds measured 
in the application. Using a balance compound is mandatory when the 
calibration model used is the fundamental parameters model or the Alpha 
model. 
Normally, the selected balance channel should be attributed to a 
compound that constitutes a very large proportion of the sample (e.g. 80 - 
90 %).
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Figure 4.9    Metal/Alloy Sample Type Definition

The only choices are if you want to use normalization or balance selections. If 
Balance required is checked, you must enter a Balance channel.
If you do not define a Balance channel, the software will request one when you 
attempt to save the data.

4.3.2.3 Fused Bead Samples

A fused bead is a solid sample made by fusing the sample material with a flux into 
a ‘glass’ bead.

Figure 4.10    Fused Bead Sample Type Definition

If you select Fused bead as the sample type, you must specify what you want the 
system to do with regard to Loss On Ignition (L.O.I.). If you check the Flux used 
check box, you must also supply the requested information.

Flux
Details of the flux used to make the bead must be defined in this window to enable 
the software to interpret the results correctly. Typical fluxes used include: lithium 
tetraborate, lithium metaborate, carbonates and nitrates.

• In the Flux field, enter the type of flux.

NOTE: The name entered for the flux must be defined as a compound 
in the system or application setup.
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• In the Initial weight field, enter the weight of sample material used to 
make the bead.

• In the Final weight field, enter the total weight of material (sample + flux) 
used to make the bead.

Loss On Ignition (L.O.I.)
The L.O.I. parameter accounts for the part of the sample that is lost when a fused 
bead is made. For example: crystalline water evaporates and carbonates are 
converted to oxides. The L.O.I. parameter is used in the calculation of 
concentrations or it can be determined by the analysis.

4.3.2.4 Pressed Powder Samples

Powdered samples are normally compressed into pellets for measurement. The 
pellet usually requires the addition of a binding agent to hold it together.

Figure 4.11    Pressed Powder Sample Type Definition

Details of any binding agent used to make the pressed powder pellet must be defined 
in this window to enable the software to interpret the results correctly. Typical 
binding agents that are used include: wax, cellulose, boric acid and citric acid.

• In the Binder field, enter the type of binding agent.

L.O.I. is balance: Any difference between the sum of the calculated concentrations 
and 100 % is assumed to be the loss from making the bead.
This option is not offered if either the check box Normalise to 
100 % or Balance is checked.

No L.O.I.: The L.O.I. value is ignored.

Ask for L.O.I.: You are requested to input the L.O.I. value before starting a 
measurement.
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• In the Initial weight field, enter the weight of sample material used to 
make the pellet.

• In the Final weight field, enter the total weight of the material (sample + 
binder) used to make the pellet.

4.3.2.5 Liquid Samples

Liquid samples require special sample cups. Solvents may be used to dissolve the 
sample material, forming the liquid. They may also be used to dilute a liquid sample.

Figure 4.12    Liquid Sample Type Definition

Details of any solvent used must be defined here to enable the software to interpret 
the results correctly. 

• In the Solvent field, enter the type of solvent.

NOTE: If you enter a name (not a formula) for the solvent here, it must 
be defined as a compound in the system or application setup, 
where you can enter the formula.

• In the Initial weight field, enter the weight of sample material.

• In the Final volume field, enter the total volume of the sample (sample + 
solvent).

4.3.2.6 Use Spinner

The sample spinner will rotate the sample while it is being measured. The sample 
spinner is designed to reduce effects caused by non-homogeneous samples. The 
inhomogeneity may be an inherent property of that type of material or sample, or it 
may even be caused by a specific sample preparation.
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An example of specific sample preparation would be the surface cleaning of metals, 
which is often done using abrasive paper. This leaves surface scratch marks, which 
tend to be all orientated in the same direction. X-ray fluorescence is very sensitive 
to surface effects. This means that the results may vary according to the sample 
orientation. The sample spinner reduces most such effects.

The sample spinner can be switched on or off on the application window using the 
check box Use spinner.

4.3.2.7 Use Default Oxides

When the check box Use default oxides is checked, the common oxide chemical 
formula of the element of interest is given in the compound name cell.

4.3.2.8 Repeat Factor

If you require the software to measure the same unknown sample more than once, 
you must set a repeat factor in the Repeat factor field of the application window. 
The effect of the repeat factor on the measuring procedure is described in Chapter 5.

NOTE: The Repeat factor field is also available in the Measure sample 
window. If you set it in the application window, you cannot change it 
in the Measure sample window. If you do not set it in the application 
window, you can then set the required Repeat factor in the Measure 
sample window.

NOTE: If the Repeat factor field is left blank or set to “0”, the measurement 
will continue endlessly until aborted by the user.

4.3.3 Selecting Channels
The channel information area of the application window allows you to select which 
elements to use in the application.

In addition, you can select moduli to be calculated as part of the application. The 
moduli can be defined at system level, see Section 3.5, or specific moduli can be 
defined for each application, see Section 4.5.

The moduli channels must have the correct special characters entered at the end of 
the name. The last character for a moduli channel must always be the character “*”.

In case your elements are present in your sample as an oxide, check the Use default 
oxides check box.
After you have defined your sample type and sample preparation data, you must 
save it before proceeding any further.
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The channel grid of the application window below shows the application setup with 
ten measuring channels.

Figure 4.13    Application Window - Channel Grid

To select an element manually for the application:

• In the Channel field, enter the element symbol.

• Click on the  button, or press Enter.

To select all elements for the application:

• Click on the periodic table button: .
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Figure 4.14    Periodic Table Window

• Select the elements you want to measure.

• Click on OK.

The new channel name is inserted into the channel grid. The measuring channels are 
listed in alphabetical order, followed by the manual input and moduli channels 
respectively. At first, the software proposes the default conditions defined at System 
level for the selected elements.

IMPORTANT: The moduli channels MUST be defined in the System moduli 
or Application moduli windows.

For light matrices (like oil or polymers), in order to correct for scatter from the 
specimen, you should create and use the Compton of the tube lines (Rh-KαC, Mo-
KαC, or use a channel with the name Bs (back scatter) or Bsn (where n = 1 to 7).

To delete a channel from the application:

• Enter the channel name into the Channel field or click on the required 
channel in the channel grid.
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• Click on the  button or press the Delete. key The channel is removed 

from the channel grid.

4.3.4 Setting the Channel Parameters
This section describes the parameters you can set for the measuring channels in the 
channel grid.

Table 4-1 Channel Parameters

Parameter Description

Compound 
name

For the main channels, this field can be edited to include chemical 
formulae or compound definitions for the compounds of interest. The 
formulae and compound definitions must be correct, as the software 
uses this data in the calculations.
NOTE: The input is case sensitive. You must use the correct 

upper and lower case letters in the chemical abbreviations 
(for example: Co = cobalt).

Unit Specifies the units in which the concentrations should be given.

Dec Specifies the number of decimals to use in the concentrations of the 
standards and results.

Seq Specifies the sequence in which the channels will be reported (if you 
enter 0 they will not be listed in the Results window).

Line name Specifies the line used to calculate the concentrations (KA, KB, LA, 
LB1, LB2, ROI). 

ROI      min Specifies the Region of Interest lower level. If you specified the line 
type as ROI, here you specify the lower level of that region in keV.

ROI      max Specifies the Region of Interest upper level in keV.

Condition 
Name

Specifies the name of the condition set to be used for the 
measurement.

Meas time Sets the measuring time. The value must be between 1 and 32767 
seconds (9 hours 10 minutes).
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To set a channel parameter:

• Click on the parameter in the channel grid that you want to change.

• Enter in the new value and press Enter.

4.3.5 Transmitting Results
In the application, you can set the details of the protocol used for results 
transmission. When the check box Transmission of results is checked in the 
System parameters window, a drop-down list is enabled with the following items:

Routine
min conc/max 

The routine minimum and maximum concentrations fields allow you 
to set concentration limits. If the measured concentration of a sample 
falls outside these limits, the result is displayed in red with either a “<” 
or “>” symbol to indicate which limit has been exceeded.

Chk sam
min conc/max 
conc

The check sample minimum and maximum concentrations fields 
allow you to set concentration limits. If the measured concentration of 
a sample falls outside these limits, the result is displayed in red with 
either a “<” or “>” symbol to indicate which limit has been exceeded.

Table 4-2 Measuring Channel Parameters

Parameter Description

Yes Transmits the results automatically. The measured results are 
transmitted to the folder that was specified in the System parameters 
window.

No Does not transmit the results.

Ask Prompts you to perform a transmission for each measurement. The 
measured results are transmitted to the folder that was specified in the 
System parameters window.

Table 4-1 Channel Parameters (Continued)

Parameter Description
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Transmission of results can be done on-line or off-line.

The transmitted files have the following file name format:

XYYYYMMDDHHMMSS.QAN

where: X is fixed
YYYYMMDDHHMMSS relate to the year (YYYY), month 
(MM), day (DD), hour (HH), minutes (MM) and seconds (SS) 
the file was saved.

The transmitted files can be imported in other applications, e.g. Excel, for further 
data processing.

4.3.6 Displaying and Printing Results
You can select what parameters are displayed in the results tables and what sample 
results are printed.

To set the display and printing options:

• In the channel information area of the application window, click on the 
Display and printing button.

• In the Display and printing window, select the required options by 
checking the check boxes.

• Click on the OK button, or press Enter. Do not forget to save the data.
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Figure 4.15    Display and Printing Window

The Values to display and print frame defines which values to display in the 
results tables.

Table 4-3 Display Items

Parameter Description

Channels Measuring channel (element) name.

Compounds Name of compound associated with that channel.

Times Channel measuring time.

Raw Intensities Directly measured count rate.

Net Intensities Intensities corrected for background.

Concentrations Calculated concentrations.

Indicators Display warning indicators.

Units Type of unit selected to display concentration results.
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The Samples and results to print automatically after measurement frame allows 
you to select the types of sample results to be printed automatically after each 
measurement is performed.

4.3.7 Optimizing Conditions
The initial proposal made by the software for the measuring conditions can be 
further optimized using few measurements on a representative sample (i.e. standard 
or routine) for that type of material. When using this procedure, only the measuring 
conditions for a specific application will change and not the original system 
conditions.

To optimize the conditions:

• Click on the Optimize Conditions button and follow the instructions.

Limits Minimum and maximum concentration limits for a channel. If the 
result is outside these limits it is clearly marked in the Results 
window.

All channels Display all channels.

Table 4-4 Print Items

Parameter Description

Standards Results of standard sample measurements, used for calibration.

Individual 
sample 
measurements

Results of routine (unknown) samples.
Check this item if you want to obtain a print of the individual 
measurements resulting from ‘repeated’.

Averages Average results of unknown samples measured more than once, 
using a repeat factor, or the result of a sample measured once 
(repeat factor 1).

Standard 
deviations

Standard deviations of unknown samples measured more than once, 
using a repeat factor.

Table 4-3 Display Items (Continued)

Parameter Description
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4.3.8 Setting an Application Password
You can set passwords for every application to prevent unauthorized personnel from 
opening and changing the application or from closing the Application measure 
sample window (if it is open).

NOTE: The application passwords are only enabled when the system password 
is enabled.

To set a password for an application:

• In the application window, click on the Set Password button.

• In the New password field, enter the password. A “*” is displayed for 
each character typed.

• Enter the password again in the Verification field.

• Click on the OK button or press Enter.

• In the navigation/control area of the application window, click on the 
Save button.

If the verification is correct, the Set new password window is cleared. If the 
verification is incorrect, an error message is displayed.

• Click on OK to clear this message and display a blank Set new password 
window, in which you can re-enter the password.

The password is only active if a system password has been set. If no system 
password has been set, the password is stored but stays inactive until the system 
password is set.

To change an application password:

• In the application window, click on the Set Password button. The Set 
new password window is displayed.

• In the Current password field, enter the current password. A “*” is 
displayed for each character typed.

• In the New password field, enter the new password.

• Enter the new password again in the Verification field.
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• Click on the OK button or press Enter. Do not forget to save the 
application.

If the verification is correct, the Set new password window is cleared. If the 
verification is incorrect, an error message is displayed and you must repeat the 
procedure.

To remove an application password:

• In the application window, click on the Set Password button. The Set 
new password window is displayed.

• In the Current password field, enter the current password.
A “*” is displayed for each character typed.

• In the New password field, do NOT enter a password.

• In the Verification field, again do NOT enter a password.

• Click on the OK button or press Enter. Do not forget to save the 
application.

4.3.9 Identifying Material by FingerPrinting
The Epsilon 3 can be used for rapid fingerprint identification of all samples types. 
The first step in the fingerprint process is the physical identification of types. Solids, 
liquids and powders should be kept separate. Furthermore, it is also advised to 
separate on the basis of grain size (for example, pellets and powders) should be 
measured using different applications.

When developing a FingerPrint application it is not necessary to have elemental 
concentrations. Simply identify the elements that would distinguish sample types/
identifications and the appropriate measuring conditions. The addition of reference 
samples/standards in the application becomes a library database of scans to which 
each measured sample is compared.
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Figure 4.16    Application Example for FingerPrint

For advanced use, it is possible to combine a calibrated method with the 
fingerprinting method. It is important to note that the combination fingerprinting 
and quantification will follow the same requirements for optimization as a routine 
quantification application. This can result in extended measurement times.

4.3.9.1 FingerPrinting Example

An example of an application for identifying General Use Materials (GUMs) is 
displayed in the figure below. The elements (defining the GUMs) were chosen and 
the appropriate corresponding condition set was employed using the default 
conditions. The time was set at 150 seconds which matched the total measurement 
time. Next the FingerPrint option was chosen by selecting the FingerPrint button.
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Figure 4.17    Finger Print Parameters Window

This one-time setup includes choosing from a variety of distinguishing factors 
controlling the Chi² regression algorithm. For first time use we recommend the 
following settings in the FingerPrint parameters window:

◆ Create a library - measure standards

Once the FingerPrint parameters have been set, simply add and measure 
standards to the database (add concentrations for methods where 
FingerPrint and quantification is desired) and measure each standard as 
per a routine application.

◆ Instant identification - results

Automatic sample identification will result when measuring samples that 
match the library database type.
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◆ XRF intelligence - capturing subtle differences

The FingerPrint software employs a sophisticated statistical algorithm that 
examines the entire scan. This includes features which are not normally 
interpreted by XRF, such as peak shape and background profiles. A key 
advantage is that fingerprinting is a fully automated method without the 
need for interpretation.

4.3.9.2 FingerPrint Parameters

Table 4-5 FingerPrint Parameter Items

Parameter Description

Use this set for 
Finger Printing

Must be checked in order to carry out finger printing.

Use spectra If this box is checked, the fingerprinting of the sample is done on 
the spectral intensities. Because some of the reference spectra could 
have been determined a long time ago, the energy scale is 
automatically adjusted.

Use fraction for 
lower energy

The low boundary of the energy range (keV) is either the ‘lower 
energy limit’ or a fraction of the max energy of the condition used 
in the application. This fraction is defined by ‘fraction lower 
energy’.

Use fraction for 
higher energy

The high boundary of the energy range (keV) is either the max 
energy of the condition used in the application or a fraction of this 
energy. This fraction is defined by ‘fraction higher energy’.

Use energy step It is necessary to choose a method of energy comparison. This 
parameter specifies step size in keV of the adjusted scan. You can 
also specify the number of steps between the lower and the higher 
energy boundary. The step size may also be varied when using this 
parameter.
Alternatively it is possible to define the Number of steps. This is 
necessary when Use energy step parameter is not checked.

Normalise 
intensities using 
TCR

The preference setting enables users to normalize the spectra by the 
Total Count Rate (TCR).
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4.4 CALIBRATING THE SYSTEM FOR AN 
APPLICATION

Analysis is achieved by comparing the measured intensity of the unknown (routine) 
samples with the regression lines established during the calibration, using standard 
samples of known composition. The regression lines are calculated for each element 
defined in the application.

The calibration consists of the following steps:

• Entering the composition data of the standard samples (see Section 4.4.1).

• Finding and calculating the line grouping (see Section 4.4.2).

• Measuring the standard samples (see Section 4.4.3).

• Performing deconvolution (see Section 4.4.4).

• Calculating the regression lines (see Section 4.4.5).

• Displaying the calibration results (see Section 4.4.6).

4.4.1 Entering Standard Sample Data
The first step in the calibration process is to define the composition of the standard 
samples. The composition is defined by entering the concentrations for the elements 
or compounds of interest. The quality of this data must also be indicated, whether it 
is known to be accurate (High) or is suspect (Low). 

If the quality of the composition data is Low, it is used for matrix correction but it 
is not directly used in the calibration of the compound.

Scale all spectra 
to requested 
counts

As the name implies, this parameter simply re-scales all the 
comparative spectra to a specified total count level. If this 
parameter is selected, a value must exist in the proceeding matrix.

Export to data 
file

Allows you to export all data to a file.

Table 4-5 FingerPrint Parameter Items (Continued)

Parameter Description
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To enter the composition of the standard samples:

• Click on the  button. The standards window for that application is 
displayed.

Figure 4.18    Standards Window

This window is used to enter the concentrations of the standard samples and to view 
the count rates obtained when measuring these samples.

To define a standard:

• In the Standard field, enter the name of the standard.

• Click on the  button. This inserts the standard into the grid.

Depending on the defined sample type, other columns for Initial weight, Final 
weight, L.O.I. and Balance automatically appear after the Standard ident field. 
The values entered in the application window are automatically inserted.
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To enter the concentration data:

• Click on the required grid cell.

• This selects the cell and places the cursor in the Edit field.

• Enter the concentration of the element.

• The value is automatically inserted and the data quality is set to High.

• Press Enter.

• Enter the concentrations for the other elements in the same way.

To change the data quality level:

• Click on the required Qual field.

• This selects that cell and copies the current setting into the Edit field.

• Type the first letter of the required level (H = High, L = Low).

• The setting is automatically inserted into the Qual field.

• Click on the  button.

• Select any other quality cells you want to change and edit the setting in the 
same way. See also Section 4.4.6.3.

To delete a standard:

• Click anywhere on the required standard in the table or enter the name in 
the Standard field.

• Click on the  button to delete the standard from the table.

To save the calibration standards input data:

• In the navigation/control area of the application window, click on the 
Save button.
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4.4.2 Finding the Line Groups
The software uses deconvolution to calculate the count rates (expressed in units of 
cps = counts per second). Deconvolution is a mathematical procedure by which the 
relative intensities of the characteristic fluorescent lines are determined by fitting 
the detector response function to the measured spectrum. In order to do that, the 
characteristic lines to be considered must be made known to the software along with 
some detector specific information.

Some elements have many lines, some of which are weak or very close together. The 
software evaluates these lines and creates the appropriate line groups.

To automatically calculate the appropriate line groups:

• In the standards window, enter all concentrations for the compounds and 

click on the  button.

The spectrum evaluation is done by non-linear least squares fitting, based on the 
AXIL algorithm developed at the University of Antwerp.

4.4.3 Measuring Standard Samples
When you have entered the standard samples concentration data, you must then 
measure the samples.

To measure the standard samples:

• Load the selected standard into the spectrometer.

• In the standards window, click on the standard(s) to measure in the grid.

NOTE: You can select multiple samples by pressing the Ctrl key or 

Shift key. Clicking on the  button at the top of the 
standards window inserts all samples into the measuring 
queue at once.

• Click on the  button at the top of the standards window.

• Select the proper position(s) on the sample changer.

• The selected sample is measured.
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4.4.3.1 Viewing Standard Samples Measurement Results

After the standard samples have been measured, the count rates can be displayed 
(but not edited) in the standards window.

To display the raw (measured) count rates:

• Click on the  button.

Figure 4.19    Standards Window

The symbols that can appear in the standards window have the following meaning:

 & The net intensities for this standard were calculated using a line overlap 
matrix that was out of date. The standard cannot be used for calibration.

 & The standard was deconvolved with the correct elements and line groups 
according to the application.

 & The intensity was obtained using conditions that do not match the current 
conditions in the application. The intensity cannot be used for calibration.
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4.4.3.2 Calculating Net Intensities for the Standards

If there are any red crosses in the table you have to measure that the standard(s) 
again or allow the software to recalculate the existing data.

To recalculate the existing data:

• Select all the standards by clicking on the top left cell of the grid.

• Click on the  button.

TIP: If you click on the  button before clicking on the  button, you will 
see the intensities appear in the table as they are deconvoluted.

4.4.4 Performing Deconvolution
After calculating the theoretical line groups and measuring the standards, it is 
advised to check and optimize the deconvolution of the obtained spectra.

To check and optimize the deconvolution:

• Select a certain standard in the standards window.

• Click on the  button. The standard spectra window is displayed 
showing the measured sample spectrum of the standard.

 & The intensity was obtained using a line which does not match the current 
line in the application (for example KA was changed to KB in the 
application), or using an R.O.I. that does not match the current 
application R.O.I. The intensity cannot be used for calibration.

 & The intensity was obtained using the correct line (or R.O.I.) and correct 
conditions according to the application.

If both    &  and  &  apply, then  &  is shown (takes priority).
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Figure 4.20    Standard Spectra Window

• In the sample spectrum window, click on the  button. The elements 
and line groups window (also called deconvolution window) is displayed, 
which consists of two tabs:

◆ Line Groups (see Section 4.4.4.1)

◆ Background Fit (see Section 4.4.4.2)

◆  When the optional Omnian software is installed, an additional tab 
Omnian is also present. For more information, see Chapter 6.

4.4.4.1 Line Groups Tab

The Line Groups tab in the deconvolution window enables the user to include/
exclude elements in order to improve the deconvolution of the standards and routine 
samples. After selection (see Figure 4.21), the software will automatically include 
those elements to the deconvolution.

In most cases, more elements are present in the standards or routine samples than 
selected by the user. Therefore it is better to include all elements in the 
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deconvolution that are present in the spectrum (spectra). In that way, calculating 
possible line overlaps and matrix effects will be more accurate.

In some cases, the deconvolution can be improved even more when the K-lines (or 
L-lines) are de-coupled from each other, like KA and KB separately (or L1, L2 and 
L3), particularly for the tube lines where the KA and KB ratio depends on the type 
of sample material.
The K-lines (or L-lines) are de-coupled by clicking on the element of interest and 
selecting/deselecting K, KA or KB line (or L, L1, L2 or L3).

Figure 4.21    Elements and Line Groups Window - Line Groups Tab

4.4.4.2 Background Fit Tab

The Background Fit tab in the deconvolution window enables the user to select the 
best background fitting model. For each different measurement condition, it is 
possible to change and optimize the background fitting by configuring:

◆ Background model

◆ Number of iterations (only applicable to background models Filter, 
Classic filter and Axil filter)
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◆ Degree of polynomial (only applicable to background models 
Exponential and Linear Polynomial)

◆ Preprocessor (only applicable to background models Filter, Exponential 
and Linear Polynomial)

Figure 4.22    Elements and Line Groups Window - Background Fit Tab

Up to 4 different ranges can be combined to deconvolute the same spectrum. Each 
energy range can have its own background model.

After any change in the deconvolution window, save the changes by clicking on the 
Save model button and recalculate the intensities for all standards in the standards 
window using the updated background model.
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Figure 4.23    Background Model

4.4.5 Calculating the Regression Lines
When the standard samples have been measured, the regression lines for all the 
elements listed must be calculated. The calculations take a number of correction 
factors into account, i.e. Alphas, fundamental parameters (FP), Compton ration 
correction and Line overlaps.

To calculate the regression lines:

• Click on the  button to display an empty calculation program 
window.
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Figure 4.24    Calculation Program Window

• Click on the  button to display the K-value, RMS and correlation 
coefficient for all the channels at the top of the grid.
NOTE: The F-value is not automatically set to be calculated.
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• In the calculation program window, select all parameters by clicking in 
the top left cell of the grid (Channel). All cells that will be calculated are 
now selected (blue).

• Click on the  button. All values to be calculated are indicated by a red 
“?” in front of the value.

Figure 4.25    Calculation Program Window - Before Calculation
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• Click on the  button to calculate the theoretical alpha factors.

NOTE: If you do not click on the  button before clicking on the  
button, you will obtain empirical alpha factors (not theoretical alpha 
factors).

• A window may be displayed informing you if any of the correction factors 
are not at a significant level. We recommend that you accept the default, 
by clicking on Yes.

Figure 4.26    Correction Factors Message

• In the calculation program window, click on the  button to calculate 
the regression values.

All the parameters have now been calculated, either by theory or 
regression analysis.
NOTE: You can fix the values of individual or groups of parameters 

you do not want to calculate by selecting the required cells and 

clicking on the  button.

• In some cases, calibration results can be improved using FPs (fundamental 
parameters) or Compton ratio correction. These corrections can be 
implemented in the calculation program when entering “F” (FP) or “R” 
(Ratio channel) in the Matrix Correction model field. For the Compton 
correction, also the Ratio Channel field must be filled with “Rh-KAC” or 
“Bs” (back scatter). These ratio channels can only be selected when 
included in the application window.
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Figure 4.27    Calculation Program Window - After Calculation

• In the navigation/control area of the application window, save the 
calibration by clicking on the Save button.

4.4.6 Displaying the Calibration Results
The calibration results for each channel can be viewed, either as a table or as a graph 
showing the regression line. These options are available from the calculation 
program window.

4.4.6.1 Calibration Results Table

The calibration report window displays the results for a channel in the form of a 
report table. It shows the relevant data of that channel for each of the measured 
calibration standards.
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To display the calibration results in a table:

• In the calculation program window, select the required channel by 
clicking anywhere in that column of the grid.

• Click on the  button at the top of the calculation program window. 
The calibration report window is displayed.

Figure 4.28    Calibration Report Window

4.4.6.2 Calibration Report Window

The calibration report window is split in two parts: the upper part shows the 
calculated regression values and the lower part shows a grid containing the 
measurement results for each standard sample.

• Double-clicking in any cell of the grid selects that standard and opens the 
calibration standards window for that application. The concentration 
value of that channel for the selected standard is highlighted.
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The calibration report window has a number of buttons for easily viewing the 
other calibration results. 

4.4.6.3 Calibration Results Graph

The calibration graph shows the calculated regression line, together with the 
calculated count rates for every standard.

To display the calibration results in a graph:

• In the calculation program window, select the required channel by 
clicking anywhere in that column of the grid.

• Click on the  button at the top of the calculation program window. 
The calibration graph window is displayed.

Table 4-6 Calibration Report Window Buttons

Button Description

Displays a graph of the results table.

Displays the results of the previous channel in the alphabetical list 
on the calculation program window in a separate window.

Displays the results of the next channel in the alphabetical list on 
the calculation program window in a separate window.

Tiles all open calibration report windows and minimizes all other 
open windows.

In addition, three application navigation buttons are available to open the 
application window, calculation program window and standards windows 
for that application.
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Figure 4.29    Calibration Graph Window

4.4.6.4 Calibration Graph Window

The calibration graph window plots the count rate (cps) against the concentration 
(%) and shows the calculated regression line for that channel. Each point marked on 
the graph is the result from the measurement and calculations applied to a particular 
standard.

The position of the mouse cursor over the graphical display is shown in the X and 
Y fields, directly above the left side of the graph. The positional units are given in 
relation to the scales.

Clicking anywhere over the graph causes the nearest data point to be selected (color 
changes from blue to green). Details of the result represented by the selected data 
point are displayed above the graph. This includes: standard name, defined 
concentration, calculated concentration, etc.

The check boxes in the upper left corner of the calibration graph window allow 
you to display additional information on the graph.
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• Double-clicking in the graph selects the nearest result point (measurement 
result from one standard) and displays the calibration standards window 
for that application. The concentration value of that channel for the 
selected standard is highlighted.

• Double-clicking on the graph scales or titles displays Calibration graph 
scales window.

• Right-clicking in the graph opens a menu that allows you additional 
functionality like Select all, Copy to clipboard, Print, Zoom/Unzoom.

If any of the standard result points are ‘outliers’ (not close enough to the calibration 
line) that should not be used for the calibration, you can mark them as low quality 
(not to be used for the regression).

To select outliers:

• Right-click in the graph and select Toggle quality or double-click close to 
the outlying point. The standards window is opened.

• In the standards window, mark the entry and change the quality to Low.

• Save the change and recalculate the regression. In the graph, you will see 
that the result point has changed from blue to red.

• This process is also completely automated by selecting menu item Toggle 
quality, provided that the ‘?’ is still available in the corresponding cell in 
the grid of the calibration report window.
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Besides the same buttons as on the calibration report window, the calibration 
graph window has the following additional buttons for easily viewing the other 
calibration results. 

4.4.6.5 Graph Scales

The parameters of the X and Y scales in the results graph can be changed to enable 
you to compare different aspects of the calibration results.

To select other graph scales:

• In the calibration graph window, double-click on the graph scales. The 
Calibration graph scales window is displayed.

• Select the required option.

• Click on the OK button or press Enter. The Calibration graph scales 
window closes and the calibration graph window shows the graph for the 
selected scales.

Table 4-7 Additional Calibration Graph Window Buttons

Button Description

Displays the results table of the graph.

Zooms out to display the complete graph.

In addition, three application navigation buttons are available to open the 
application window, calculation program window and standards windows 
for that application.
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Figure 4.30    Calibration Graph Scale Window

4.5 OPTIONAL APPLICATION FUNCTIONS
A number of the functions in the application window and some of the other 
windows can be optionally defined. They are not required for the basic application 
definition, but provide additional options. See also the Epsilon 3 On-line Help.

NOTE: The Statistical Process Control (SPC) option is described in Chapter 7.
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Table 4-8 Optional Application Functions

Function Associated Epsilon 3 Software Window

Ident system function Ident system window

Application moduli definitions Application moduli functions window

Application compounds definitions Application compounds definitions 
window
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Chapter 5. Measuring Samples
5.1 INTRODUCTION
In this chapter we describe how to perform measurements of routine (unknown) 
samples.

The measurement of routine samples is normally carried out within a defined 
application, but samples can also be measured using the manual control function.

NOTE: If you are performing quantitative analysis, the measurement of 
calibration standards must be done prior to measuring unknown 
samples and is described in Chapter 4.

5.1.1 Measurement Overview
The steps for carrying out measurements are listed briefly below. These steps are 
described in detail in the following sections.

• Load the sample.

• Open the measure window for the required application.

NOTE: Up to 10 samples can be loaded in the spectrometer.

• Give an identity code to the sample.

• Start the measurement.

The progress of a measurement can be monitored on the status bar. More detailed 
status information can be viewed on the Online status window. The results are 
available as soon as the measurement is complete on the Last result window.
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5.2 SAMPLE LOADING
Solid samples must be between 27 and 51.5 mm diameter with a maximum height 
of 4.9 cm on Epsilon 3 (with standard lid) and 10 cm on Epsilon 3 XL (with high 
lid) respectively. Liquid samples (typically 10 ml) must be placed in the special 
“P1” or “P2” plastic cup sample holders. These sample holders are then loaded in 
the same way as solid samples. Steel rings must be between 40 and 51.5 mm 
diameter.

The samples are loaded into the sample changer manually.

To load a sample into the spectrometer:

• Lift the spectrometer lid.

• Place the sample in the required position on the sample changer.

• Close the lid.

When you measure the sample, the sample and its position in the changer have to be 
identified to the software. This is done using the Select changer position window.

5.3 MEASURING A SAMPLE
Measurements of routine samples are normally carried out from an application (see 
Section 5.3.1 and Section 5.3.2). Alternatively, individual samples can be measured 
from the Manual control window (see Section 5.3.3).

Caution General hazard

Extra care must be taken with liquid samples to avoid 
damaging the liquid sample holder in any way, as this 
may cause the liquid to leak into the spectrometer.
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5.3.1 Measuring a Routine Sample

5.3.1.1 Opening the Measure Sample Window

To open the measure sample window from the menu bar:

• Select Measure > Measure application. The Measure application 
window is displayed.

Figure 5.1    Measure Application Window

• Select the application to measure and click on OK or press Enter. The 
measure sample window of the selected application is opened.

Figure 5.2    Measure Sample Window
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To open the measure sample window from the toolbar:

• Click on the  button. If no measure sample windows are currently 
open, the Measure application window is displayed. Select the 
application to measure and click on OK or press Enter. The measure 
sample window of the selected application is opened.

• If one measure sample is already open, that measure sample window is 
made the active window and displayed on top.

• If more than one measure sample windows are already open, the software 
asks which measure sample window to open.

To open the measure sample window from an application window:

• In the navigation/control area of the application window, click on the 

 button. The measure sample window of the current application is 
opened.

5.3.1.2 Measuring the Sample

• In the Sample ident field, enter the name of the sample.

NOTE: This step is not necessary if the samples are automatically 
named by the application sample ident function.

• Load the sample into the spectrometer.

• Click on the Measure button to start the measurement. The Select 
changer position window is displayed.
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Figure 5.3    Select Changer Position Window

• In the Select changer position window, click on the position of the 
sample.
The measurement will start automatically if the spectrometer is ready. If it 
is not ready (e.g. the lid is open or the gain is being measured) the 
measurement will not start.

• You can then set up further measurements by clicking on the Measure 
button and defining the position to measure. These settings are stored and 
the measurements are carried out when the current/previous measurements 
are complete.

• You can also change applications between measurements by selecting the 
Measure application window for a different application and then clicking 
on the Measure button in the new window.
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5.3.1.3 Sample Changer Window

The Sample changer window shows the status of the sample changer, including its 
current position and which positions have samples defined. It can also display 
details of the samples in the measuring queue.

Samples can be deleted individually or all at once.

To open the Sample changer window:

• Select Measure > Sample changer or click on the  button in the 
Online status window.

Figure 5.4    Sample Changer Window
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The top left frame of the Sample changer window shows the status of the sample 
changer by a schematic picture, similar to the Select changer position window.

◆ Defined sample changer positions are shown with a white number on a 
blue background. Undefined positions are shown as a black number on a 
white background. 

◆ The current position of the sample changer is shown by the yellow circle, 
indicating the measuring position.

The Sample information frame in the middle of the Sample changer window 
shows detailed information of the sample currently in the measuring position, 
including sample type (normal, calibration) and related application.

5.3.2 Easy Measuring
It is possible to set up the software to perform easy measurement of samples, for 
example if you have already set up a condition set and an open the application 
window.

• Open a Measure application window (see Section 5.3.1).

• Click on the  button on the toolbar. The Last result window and the 
Easy measure window are displayed. The Easy measure window 
contains a large green button with the application name.

Figure 5.5    Last Result + Easy Measure Window

• In the Easy measure window, click on the green application button. An 
Easy measure window is displayed.
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Figure 5.6    Easy Measure Window

• In the Sample ident field, enter the sample identity and click on the 
Measure button. The Select changer position window appears.

• In the Select changer position window, click on the position of the 
sample. The measurement will start automatically if the spectrometer is 
ready. 

Every Measure application window that you now open created another green 
application button in the Easy manage window.

An application button remain active as long as the Measure sample window of that 
application is open or minimized. As soon as the Measure sample window is 
closed, the related application button disappears.

Up to 8 applications can be opened simultaneously in the Easy measure window.
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Figure 5.7    Easy Measure Window

5.3.3 Manual Measuring
The measurement of routine samples is normally carried out from a defined 
application, but samples can also be measured using the manual control function.

• Select Measure > Manual control or click on the  button on the 

toolbar or in the Online status window, click on the  button. The 
Manual control window is displayed.
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Figure 5.8    Manual Control Window

• Place the sample in the sample changer.

• In the Sample changer frame of the Manual control window, enter the 
position of the sample and click on the Move button.

• Select or enter the measuring medium (Medium), measuring voltage (kV) 
and current (µA), filter (Tube filter), and measuring time (True time).
You can also use the measurement conditions from an existing application 
by clicking on the Get button and selecting the name of the application.

• In the Ident field, enter a recognizable name for the measurement or check 
the Auto ident check box.

• Start the measurement by clicking on the Measure button in the Manual 
measurement frame.
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To view the results of the manual measurement:

• Select Results > Open results. The Open results window is displayed.

Figure 5.9    Open Results Window

• Select <Manual> and click on the OK button. The <Manual> results 
window is displayed.

Figure 5.10    <Manual> Results Window
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• Double-click on the sample of which you want to see the results.

• Click on the  button.

• When you have a Results spectra window open, you can click on the 

 button to show the elements and line groups.

• You can now proceed to handle the results as described in Chapter 7, or, if 
you want the software to check what elements are present (qualitative 

analysis), you can click on the  button and the system will then 
highlight the elements present.

5.3.4 Measuring Large Samples
Measuring large samples is only possible for solid samples with a maximum height 
of 4.9 cm on an Epsilon 3 with a standard lid, and a maximum height of 10 cm on 
an Epsilon 3 XL with high lid.

To measure large samples:

• Turn off the HT.

• Open the lid.

• Remove the sample tray.

• Move the spinner arm back so that it is away from the measurement 
position.

• Position the large sample above the measurement position as shown in the 
figure below.

• Leave the lid open otherwise large sample mode cannot be selected.

NOTE: You cannot make automatic gain control measurements while in large 
sample mode.
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Figure 5.11    Example of Large Sample Positioning

• Select System > Enter “Large Sample” mode. A message is displayed 
indicating to remove the sample tray and to move the spinner arm back so 
that it is away from the measurement position.
NOTE: It is strongly advised to place a foil on top of the measuring 

station. Refer to the Epsilon 3 User’s Guide.

• Click OK to continue.

• Close the lid.

• Switch on the HT.

• Measurements of large samples can now be carried out from an 
application (Section 5.3.1 and Section 5.3.2).
Alternatively, individual samples can be measured from the Manual 
control window (Section 5.3.3).

To stop measuring large samples:

• Turn off the HT.

• Open the lid.
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• Select System > Exit “Large Sample” mode. A message window is 
displayed indicating to remove any large sample, to replace the sample 
tray and to move the spinner arm forwards to engage the spinner cog 
wheel.

• Click OK to continue.

• Close the lid. The sample changer now moves to the reference position.

• Switch on the HT.

5.4 MEASUREMENT RESULTS
After a measurement has been completed, the results can be viewed in the Last 
result window and stored in the application database. The stored results can be 
recovered for further processing, see Chapter 7.

NOTE: The Last result window is one of the four windows that are displayed 
when the software is started. It cannot be closed, but it can be 
minimized.

Figure 5.12    Last Result Window
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The Last result window, as its name suggests, always contains the result of the last 
measurement carried out. It shows the measuring time, count rate (in cps) and 
concentration for each measured channel, as well as details of the sample and 
application.

Any concentration values that are outside the optional limits set in the application 
window, are displayed in red. This gives you an immediate visual indication of 
possible problems.

5.5 REPEAT MEASUREMENTS
If the check box Repeat Factor is checked in the application window, the same 
sample is measured for the defined number of times. This is carried out 
automatically by the software, which shows the number of the current measurement 
in the measure window.

The field can be blank, “0” or a number between “1” and “9999”.

◆ If blank you must specify “0” or a non-zero number smaller than “9999” in 
the Measure window.

◆ If “0” the sample will be measured indefinitely (until aborted).

◆ If a number between “1” and “9999”, the sample will be measured the 
specified number of times.

The results of each measurement are stored separately. Additionally, for repeated 
measurements on one sample, the average and standard deviation results are 
calculated and stored.

When the measurement is complete, the Last result window shows the complete 
results for all repetitions and the average and standard deviation values.
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Figure 5.13    Last Result Window
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6.1 INTRODUCTION
The optional Omnian program can be used for characterization and analysis of 
unknown samples, or in situations where certified standards that match specific 
sample characteristics, are not available. Important applications include sample 
quantification, screening, failure analysis, as well as the comparison of different 
materials. Omnian can handle a wide variety of sample types such as solids, pressed 
powders, fused beads, loose powders and liquids. 

Importantly, Omnian corrects for sample characteristics - thickness, volume and 
unmeasured ‘Dark-Matrix’ compounds, and adapts automatically to sample 
characteristics and associated matrix effects.

Omnian analysis uses fundamental parameters (FPs) to calculate the propagation of 
X-rays from the X-ray tube through the optical path to the detector. Observed 
intensities are compared with calculated intensities in order to give an estimate of 
the concentrations in an unknown sample.

This is done using an iterative method:
1. Assume a concentration

2. Predict the signal

3. Compare with measurement

4. Tune the concentrations

5. Return to predict the signal

The loop is repeated until the predicted signal matches the measured signal.

NOTE: It is essential for this method that it is known exactly what is happening 
in the optical path. All parameters must be known with at least the 
accuracy that is required for the concentrations. Parameters are tube 
spectrum, tube window thickness, propagation of X-rays in the measure 
chamber medium, thickness and composition of filters, etc.
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6.2 PREPARING OMNIAN MEASUREMENTS
Before the Omnian routine measurements can be performed, the following 
preparations are required:

1. Carrying out Omnian sample preparation (see Section 6.2.1) 

2. Creating Omnian sample parameters (see Section 6.2.2)

6.2.1 Carrying Out Omnian Sample Preparation
• Select Omnian Setup > Manage sample preparations. The Measure 

Sample Preparations window is displayed.

Figure 6.1    Manage Sample Preparations Window

• Click on the New button. The New Sample Preparations window is 
displayed.
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Figure 6.2    New Sample Preparation Window

• In the Name field, enter a name (e.g. Omnian - Solid) for the new sample 
preparation and click on the Create button. The Sample Preparation 
window is displayed.

Figure 6.3    Sample Preparation Window
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• In the Sample Type field, select Solid.

• Check the check box Enter weight and size.

• Enter the correct values in the fields Weight and Diameter. If finite 
thickness correction is needed, also enter the correct thickness of the 
sample in the Thickness field.

• Click on the Save button.

• Close the Sample Preparation window.

6.2.2 Creating Omnian Sample Parameters
• Select Measure > New Omnian sample parameters. The New Omnian 

sample parameters window is displayed.

Figure 6.4    New Omnian Sample Parameters Window

• In the New Omnian sample parameters field, enter a name (e.g. Omnian 
- Solid) for the sample parameters and click on the Create new button. 
The Omnian sample parameters window is displayed.
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Figure 6.5    Omnian Sample Parameters Window

• In the Omnian sample preparation used for quantification field, select 
Omnian - Solid.

• Click on the OK button.

The Omnian measurement preparation is now completed and a routine Omnian 
measurement can be carried out (see Section 6.3).
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6.3 PERFORMING A ROUTINE OMNIAN 
MEASUREMENT

• Select Measure > Measure Omnian Sample. The Measure Omnian 
Sample window is displayed.

Figure 6.6    Measure Omnian Sample Window
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If the sample you are going to measure has not been defined, enter the sample 
definition as follows:

• In the Enter your sample identification here field, enter the sample 
identification. Without this sample identification it is not possible to start 
the measurement.

• In the Omnian Calibration used for quantification field, select 
Omnian. The Omnian calibrations must be set up previously in Omnian 
Setup > Manage Calibration.

• In the TAG used for quantification field, select a TAG for the 
calibration. For Omnian the default TAG is GENERAL. 
Tags can be used as a keyword or term associated with or assigned to a 
piece of information used to steer the quantification of unknown routine 
samples. Tags can be set up in Omnian Setup > Tags and additives.

• In the Omnian Sample Parameters to be applied field, select an 
appropriate Omnian sample parameter.

• If drift correction is required, check the check box Apply drift correction.

• In the Manual Input grid, enter the correct values of the weights (e.g. 
from the sample and additives).

• When a foil is used (for example when measuring a liquid sample), check 
the Foil Used check box and select the foil that is used for the 
measurement. The thickness and density are filled in automatically.

• When applicable, select an Omnian Compound List. An Omnian 
compound lists must be previously created in Omnian setup > Manage 
Compound Lists.

• When applicable, select a List for known elements used for 

deconvolution. Click on the  button to select the elements of interest.

To display the Omnian measuring conditions:

• Click on the  button. The Omnian condition sets window is 
displayed.
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Figure 6.7    Omnian Condition Sets Window

• If necessary, change the value of the Measuring time into the grid.

• If you agree with the conditions, click on the OK or Save button. Click on 
the Cancel or Reset button to cancel or abort the operation. The Omnian 
condition sets window is closed, returning to the Measure Omnian 
sample window.

To change the display and printing options:

• Click on the Display and printing button. The Display and printing 
window is displayed.
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Figure 6.8    Display and Printing Window

• Select the required options by clicking in the check boxes. See Section 
4.7.2 for detailed information.
NOTE: When using Omnian measurements, the field Standards is not 

applicable.

• Click on the OK button or press Enter.

To start the Omnian measurement:

• Ensure that the sample is available in the sample changer.

• Click on the Measure button.

• In the Sample changer position window, select the sample to be 
measured.

• If necessary, optimize deconvolution (see Section 4.8.4).

The measurement will be carried out and the results will be available in the Last 
result window.
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Figure 6.9    Last Result Window

6.4 OMNIAN MONITOR
The application Omnian Monitor is included in the Omnian software package, 
together with a monitor sample FLX C3. If the pre-calibration is done in the factory, 
then the first measurement of the Omnian Monitor is done in the factory.

6.4.1 Measuring the Omnian Monitor Sample
• Select Measure > Measure application.

• In the Measure application window, select Omnian Monitor.

In the measure sample window, select Recal standard as measurement 
type.
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Figure 6.10    Omnian Monitor Measure Sample Window

• Click on the Measure button to start the measurement.

• In the Select changer position window, click on the position of the 
Omnian monitor sample. The measurement will start automatically if the 
spectrometer is ready.

• After the measurement is finished the correction factors are automatically 
updated and the Automatic recalibration succeeded window is 
displayed.

• Click on the Close button.
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6.4.2 Applying Drift Correction for the Omnian 
Sample

• In the Measure Omnian Sample window, check the check box Apply 
drift correction and click on the Measure button.

Figure 6.11    Measure Omnian Sample Window

• After the measurement, open the results window and select a 
measurement. Then click on the right mouse button to open the results 
pop-up and select Display the spectra.
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• In the results spectra window, click on the  button. The elements and 
line groups window is displayed.

• Select the tab Omnian.

Figure 6.12    Elements and Line Groups Window - Omnian Tab
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This window has two check boxes for drift correction:

• Check the required drift correction check boxes and click on the Quantify 
button.

Apply drift correction Applies the drift correction factors stored with the result.

Use current drift factors If checked, the software applies the current drift factors. 
This is useful in situations where the routine sample was 
measured without an up-to-date monitor. After the monitor 
is re-measured, the drift factors can be checked and the 
sample recalculated.
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7.1 INTRODUCTION
The results stored in the database can be accessed using the results window. The 
results for either the routine (‘Unknowns’) or ‘Standards’ samples can be displayed, 
backed up to an external disk (to make a backup database) or combined into reports. 
The results can also be shown graphically.

7.2 HANDLING APPLICATION RESULTS

7.2.1 Results Window
To open the results window:

• Select Results > Open results or click on the  button in the 
navigation/control area of the Application window. The Open results 
window is displayed.

• Select the required application.

Figure 7.1    Results Window
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◆ The upper half of the results window handles searching the results 
database, displaying the search results and what actions to carry out on the 
selected results. It also shows the number of results in the database 
selected and highlighted for processing.

◆ The lower half of the results window displays the results of the 
highlighted results, showing either the calculated average values for all the 
results or the standard deviations.

7.2.2 Searching Results
The fields in the upper half of the results window can be used to define a search of 
the database.

• Enter the search criteria:

◆ Database: Main Db or Backup

◆ Sample type: Unknowns, Standards, Check sam or Routine

◆ Results type for repeat measurements: Average or Std.Devs

◆ Sample ident as a text string: Ident search mask
NOTE: The asterisk character “*” or question mark “?” can be 

used in the searches as a wild card to represent one or 
more characters.

◆ Date and time limits: Earliest date and time and Latest date and 
time

• Click on the Search button.

7.2.3 Selecting and Handling Results
The search criteria that match the selected results in the application database are 
listed in the results window. Actions can be performed on the results using toolbar 
buttons or the right mouse button menu.

7.2.3.1 Using the toolbar

The toolbar on the upper half of the results window contains several fields and 
buttons for selecting and handling the results.
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.

7.2.3.2 Results Pop-up Menu

Clicking on the right mouse button in the results window opens the results pop-up 
menu, which contains the following items:.

Table 7-1 Upper Half Results Window Fields and Buttons

Menu Item Function

In file Shows the number of entries in the database.

Select Shows the number of results recovered with the defined search.

Highlight Shows the number of recovered results that are highlighted.

Highlights all the results.

Prints the contents of the highlighted results.

Table 7-2 Results Pop-up Menu Items

Menu Item Function

Export 
selected 
spectra

Exports the data of one spectrum into a text file, including the selected 
condition sets. Spectra are exported by default as MPS files. You can 
also export as SPE files. The MPS files have more information in the 
header. The Export spectrum window is displayed to specify the 
filename.

Transmit 
results

Transmits the highlighted results on-line or off-line. This menu item is 
only available when the check box Transmission of results in the 
System parameters window is checked. The sample results are 
written to the folder specified in the System parameters window. You 
can select to transmit results to a single file or to individual files.
Selecting Transmission of results > To a single file will display the 
Transmit Samples window to enter the filename.
Selecting Transmission of results > Transmission to individual files 
will create output files as specified in Section 3.2.6.
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7.2.4 Backing up the Database
Results from the database can be saved to another disk in order to backup important 
data or to transfer data from one PC to another.

• Select System > Backup userdata.

• The Backup userdata window is displayed showing the source folder.

• Select the destination folder and click on the Backup button.

7.2.5 Deleting Results
Any or all of the displayed results can be deleted in order to remove unwanted 
results from the storage device.

• In the results window, select the required results.

• Click on the  button. A message is displayed for confirmation.

• Click on the Yes button to delete the file.

Display 
results

Displays all the elemental concentrations for each selected sample, 
including the average concentration and the standard deviation of the 
selected samples.

Export to file Exports the results by default as TXT files. Exported results files can 
also be imported into office applications. The Export spectrum 
window is displayed to enter the filename.

Display 
selected 
spectra

Displays the Results spectra window of all highlighted samples.

Table 7-2 Results Pop-up Menu Items (Continued)

Menu Item Function
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7.2.6 Processing Results
The highlighted results can be processed and the results shown in the lower half of 
the results window. Two processing functions are available:

◆ Averaging

◆ Standard deviation

The averaging and standard deviation functions display a range of values as 
configured in the Display and printing window. This can include the average 
values or standard deviation values of measured count rates, corrected count rates 
and concentrations for all the measured channels, calculated over the highlighted 
results.

The calculated results shown in the grid can be printed by clicking on the  
button, located immediately above the grid.

How the results are displayed varies slightly with the sample types:

◆ If needed, for unknown samples (Unknowns), check samples (Check 
sam) and routine samples (Routine), Net count rate can also be 
displayed.

◆ For standard samples (Standards), the known concentrations are shown in 
the Conc column.

7.2.6.1 Averaging

• Click on the  button to display the average values of the highlighted 
results.

• The calculated averages are displayed in the grid in the lower section of 
the results window. 
The Seq field indicates that the averaging process has been performed by 
the term Ave/x, where x is the number of results used in the calculation.

7.2.6.2 Standard Deviation

NOTE: More than one result must be highlighted before standard deviations can 
be calculated.

• Click on the  button to display the standard deviation values of the 
highlighted results.
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• The calculated standard deviations are displayed in the grid in the lower 
section of the results window. 
The Seq field indicates that the standard deviation process has been 
performed by the term Sdev/x, where x is the number of results used in the 
calculation.

7.2.7 Displaying Graphical Results
The selected results can be displayed graphically in a results graph window. The 
graph can also be printed out as part of a report.

• In the results window, select the required results.

• Click on the  button. The results graph window is displayed.

7.2.7.1 Results Graph Window

Figure 7.2    Results Graph Window
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A number of fields and check boxes are available for customizing the display. In 
addition, a number of information fields are presented, shown with a green 
background..

Table 7-3 Results Graph Window Fields and Buttons

Menu Item Function

X Shows the Y axis position of the mouse cursor.The unit is the 
same as the unit of the scale.

Y Shows the Y axis position of the mouse cursor.The unit is the 
same as the unit of the scale.

Sample ident 
field 

Clicking with the mouse anywhere over the graph causes the nearest 
data point to be selected (color changes from blue to green). The 
sample ident of the results file name corresponding to this data point is 
also displayed in the information fields directly above the graph.

Grid Superimposes a grid over the graph.

Titles Displays the names of the axis in the graph area. This information is 
identical to that shown in the X and Y axis scale fields.

Trace Draws a line joining all the data points in the graph, in the order they 
appear along the X axis.

Stats Draws the statistical lines onto the graph.

X axis scale Defines which units are used for the X axis:

◆ Time (default): date ant time the samples were measured

◆ C (%): concentration in %

◆ C (ppm): concentration in ppm

◆ I (cps): count rate in cps

Y axis scale Defines which units are used for the Y axis:

◆ C (%): concentration in %

◆ C (ppm): concentration in ppm

◆ I (cps): count rate in cps
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7.2.7.2 Handling Graph Results

To select a result:

• Click on or near a result in the graph. The selected result is shown in a 
different color than the other results and the measurement time and 
identification fields of the selected result will be filled.

To show a result:

• Double-click on or near a result in the graph. The selected result is 
displayed in the periodic table of the elements and line groups window, 
which will automatically be displayed.

To edit a result:

• Click on the right mouse button in the results graph window to open the 
edit pop-up menu, which contains the following items:

X (drop-
down)

Directly displays the X axis selection.

Y (drop-
down)

Allows you to select which measured channel to display.
Additionally, if Y axis scale is I (cps), you can select to the following 
items or this axis:

◆ Raw

◆ Net 

◆ Corrected

Table 7-4 Edit Menu Items

Menu Item Function

Select all This item is disabled for spectra and graphs.

Table 7-3 Results Graph Window Fields and Buttons (Continued)

Menu Item Function
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7.2.8 Transmitting Results
Results from the application database can be transmitted to a folder on your hard 
drive in order to import data or to transfer data into other applications.

Transmitting the highlighted results can only be done off-line. This function is only 
available when the check box Transmission of results in the System parameters window is 
checked. 

The results are written to the folder specified in the System parameters window. See also 
Section 4.7.1. The folder must be an existing folder on your hard drive. The file 
name will be the same as the sample result date (XYYYYMMDDHHMMSS with 
the extension QAN). The measurement results can be used by other applications for 
further processing.

To transmit results:

• In the results window, select the required highlighted results.

• Click on the  button.
If you have selected more than one result, a file transfer confirmation 
message is displayed asking if you want to confirm each transfer 
separately.

Copy to 
clipboard

Copies the graph to the clipboard.

Print Prints the current graph.

Export data 
points

Exports the data of one result graph into a text file. The Export 
data points window is displayed to specify the file name. Data 
points are exported by default as EDP files. These files can also 
be imported into spreadsheet applications.

Zoom Zooms in on the graph.

Unzoom Zooms out to the original size of the graph, with all the points fitted on 
the graph.

Table 7-4 Edit Menu Items (Continued)

Menu Item Function
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• Click on the Yes button if you wish to confirm each transmission, click on 
the No button to transmit all results automatically.

• When you clicked on the Yes button, a message window is displayed 
before each transmission. Click on the Yes button to transmit the results of 
the sample.

7.3 HANDLING SPECTRA
If you have a sample that you have measured, but you do not know what elements 
are present in the sample, you can use the quantitative analysis capabilities of the 
Epsilon 3 software to find out what is present in your sample.

To open the result spectra window:

• Select Results > Open results to open the Result spectra window 

• Select the results you require and click on the  button. The result 
spectra window opens showing the spectra of the selected measurement.

Figure 7.3    Result Spectra Window
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To edit the result spectra window:

• Click on the right mouse button in the result spectra window to open the 
edit pop-up menu, which contains the following items:.

Table 7-5 Edit Menu Items

Menu Item Function

Select all This item is disabled for spectra and graphs.

Copy to 
clipboard

Copies the graph to the clipboard.

Print Prints the current graph.

Export 
spectrum

Exports the data of one spectrum into a text file including the 
selected condition sets. The Export spectrum window is displayed 
to specify the file name. Spectra are exported by default as MPS 
files. You can also export as SPE files. The MPS files have more 
information in the header. The importing of result spectra can be 
used as offline measurements in the Epsilon 3 software. Exported 
spectra files can also be imported into spreadsheet applications.

Zoom Zooms in on the graph.

Unzoom Zooms out to the original size of the graph, with all the points fitted 
on the graph.

Change X axis Defines the scale used for the X axis.

Show data for 
multiple spectra

Shows a grid with information of all selected spectra.

Remove selected 
sample

Removes the selected sample from the graph.

Intensity offset Increases or decreases an offset for all spectra.You can also reset the 
offset to its original value.

Show in 3D Shows the spectra in a three dimensional view.
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To view multiple spectra in the results spectra window:

• In the Edit menu, click on Show data for multiple spectra to view all 
selected spectra together in the results spectra window.

Figure 7.4    Results Spectra Window with Multi Spectra Data

NOTE: It is possible to adjust the ROI on the results spectra window by 
pressing the Shift key and the left mouse button at the same time.
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To view the spectra in 3D:

• In the Edit menu, click on Show in 3D to view the 3D representation of 
the results spectra:

Figure 7.5    3D Results Spectra Window

NOTE: The Graph ROI area is not shown in the 3D results spectra window.
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To view the elements present:

• In the results spectra form, click on the  button to show the elements 
and line groups window.

• Click on the  button to highlight the elements that are present in the 
elements and line groups window.

Figure 7.6    : Elements and Line Groups Window showing Elements Present
Page 7 - 16



Chapter 8

Statistical Process Control (SPC)
8.1 INTRODUCTION............................................................ 8 - 3

8.2 TERMS AND DEFINITIONS FOR SPC ............................ 8 - 3

8.3 SETTING UP SPC ........................................................... 8 - 5
8.3.1 SPC Setup Window ........................................................................... 8 - 5
8.3.2 Selecting Channels for SPC............................................................... 8 - 8
8.3.3 Initializing the SPC Data File ............................................................ 8 - 8

8.4 CALCULATING SPC LIMITS........................................... 8 - 9
8.4.1 Initial Limit Calculation .................................................................... 8 - 9
8.4.2 Automatic Limit Recalculation........................................................ 8 - 10
8.4.3 Manual Limit Recalculation ............................................................ 8 - 10

8.5 CHECKING SPC LIMITS ............................................... 8 - 11
8.5.1 Value Out of Limits ......................................................................... 8 - 12
8.5.2 Sequence of Increasing or Decreasing Values................................. 8 - 12
8.5.3 Sequence of Values Above or Below the Average.......................... 8 - 12

8.6 SPC VALUES................................................................ 8 - 13
8.6.1 SPC Values Window ....................................................................... 8 - 13
8.6.2 SPC Graph Window......................................................................... 8 - 14
8.6.3 SPC Counters Window ....................................................................8 - 15
8.6.4 SPC Warnings Window................................................................... 8 - 16

Statistical Process Control (SPC)
Page  8 - 1



Epsilon 3 Quick Start Guide
Page 8 - 2



Chapter 8. Statistical Process Control (SPC)
8.1 INTRODUCTION
Statistical Process Control (SPC) enables you to monitor the stability of a process. 
SPC continuously checks the measurement results and alerts you to possible 
problems. This continuous monitoring of the results not only spots individual results 
that are outside the limits, but also recognizes long term trends in the measuring 
results, that are unlikely to be spotted by the operator. This assists you in taking 
corrective action quickly and efficiently.

A process is monitored by selecting a number of values that can be measured and 
that should remain constant over a long time period. Each of these values is analyzed 
repeatedly and checked for certain trends and limits. Each particular value will have 
its own limits. The trends looked for will normally be similar for all the values used 
to monitor a particular process.

The spectrometer is designed to measure concentrations of elements or compounds 
in samples. You will therefore normally use concentration values as the input to the 
SPC calculations. But, you can use the measured intensity values instead of the 
concentrations.

SPC must be set up for each application, if required. When the SPC protocol is 
initiated for an application, each set of results is sent to the SPC module. Initially, 
the results are stored in the SPC data file for that application until there are enough 
results to establish the limits and constraints. Then all new results are checked 
against the SPC limits and constraints. If a limit is violated, a warning is displayed 
immediately.

8.2 TERMS AND DEFINITIONS FOR SPC

Table 8-1 : SPC Terms and Definitions

Term Explanation

Individual
X-values

Each measurement result is treated individually as an X (average) 
value. It is not possible to use R (range) values with individual data 
values.

Groups The sample measurement results are split into data groups for 
analysis. These data groups may be between 2 and 24 samples long 
and may or may not overlap, as required. When a data group is 
completed, new X- and R-values are produced which can be 
analyzed.
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X-values These are the averages of the samples in each data group. This can 
also be used for individual samples.

R-values These are the ranges of the samples in each data group. The 
R-value for a group is the maximum data value minus the 
minimum data value in that group.

Control groups These are the data groups of the initial measurement results stored 
to calculate the limits and constraints for SPC.

Control limits These are calculated from the control groups and give the allowed 
ranges for the X- and R-values, that are produced as subsequent 
samples are measured. The control limits cannot be calculated until 
sufficient samples have been measured to generate the required 
number of control groups.

Sigma This is the standard deviation values used for the control limits. 
The values are normally estimated by applying a simple formula to 
the average of the R-values in the control groups.

Real Sigma Sigma values are calculated by finding the standard deviations for 
the X- and R-values in the control groups.

Limit checks Test that each individual sample or group falls within the defined 
X-and R-values limits (UCL and LCL) for that check.

LCL Lower Control Limit. This is the lowest permitted value for that 
limit check. It is set three sigma below the calculated mean value.

UCL Upper Control Limit. This is the highest permitted value for that 
limit check. It is set three sigma above the calculated mean value.

Maximum 
sequence

These checks count the current sequences of X-values or R-values, 
which are continuously increasing/decreasing or above/below the 
mean value. The length of any such sequence is compared to the 
maximum permitted length, set on the SPC setup window.

Table 8-1 : SPC Terms and Definitions (Continued)

Term Explanation
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8.3 SETTING UP SPC
The SPC setup window can only be accessed from the application windows.

8.3.1 SPC Setup Window
To open the SPC setup window:

• In the navigation/control area of the application window, click on the 

 button. The SPC setup window is opened.

Figure 8.1    SPC Setup Window
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The fields in the SPC setup window allow you to define all the parameters for the 
SPC checks:

Table 8-2 : SPC Setup Window Fields

Field Description

Individual X-values If checked, each X-value is one sample result.
If cleared, each X-value is the average of a group of sample 
results.

Overlapping groups If checked, the groups of samples overlap (each group starts 
one sample after the previous group started).
If cleared, the groups of samples do not overlap (a new 
group starts directly after the previous group).

Number of Samples per 
group

Specifies the group size between 2 and 24.

Number of Groups in 
limit calc

Specifies the number of groups over which the SPC limits 
are calculated.

Number of Groups in 
data file

Specifies the total number of groups (or individual samples) 
stored in the SPC data file.

Use real sigma for 
control limits

If checked, the real standard deviations of the X- and 
R-values to set the control limits are calculated.
If cleared, estimated sigma values are used.

Use real sigma for recal 
checks

If checked, the real standard deviations of the X- and 
R-values are used when doing recalibration checks.
If cleared, the estimated standard deviations of the X- and 
R-values are used when doing recalibration checks.

Automatic plot on limit 
recal

Plots the final X/R chart automatically before the 
recalculation.

Automatic plot on limit 
violation

Plots an X/R chart automatically when one of the checks 
fails for a channel. 
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NOTE: Recalculation can be disabled by leaving the field Number of samples 
per group blank.

Nr of values checked for 
limit recalculation
(X-values and R-values)

A record is kept of the number of X-values set in this field. 
If the percentage of these X-values within 1-sigma of the 
average is not within the defined range, the SPC limits are 
recalculated, providing no SPC limits have been violated.
If this number is left blank, a record is kept of all X-values, 
but no limit recalculation is done.

Min % in 1-sigma range 
for no recalculation
(X-values and R-values)

Specifies the lower limit for the allowed percentage of 
X-values within 1-sigma of the average.

Max % in 1-sigma 
range for no 
recalculation 
(X-values and R-values)

Specifies the upper limit for the allowable percentage of 
X-values within 1-sigma of the average.

Number of samples 
back to recal start

Sets the offset from the last sample to the first sample to be 
used in a limit recalculation. This offset must cover enough 
samples for SPC limit calculation and must not exceed the 
number of samples in the file.

Check control limits
(X and R)

If checked, the system checks that the X and/or R are within 
the control limits.

Max sequence 
increasing or decreasing

Sets the number of sequentially increasing or decreasing 
X-values that generate a warning message. If this is set to 
zero, no check is made.

Max sequence above or 
below the mean

Sets the number of sequential X-values above or below the 
average that generate a warning message. If this is set to 
zero, no check is made.

Table 8-2 : SPC Setup Window Fields (Continued)

Field Description
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8.3.2 Selecting Channels for SPC
The measuring channels in the application to which you wish to apply SPC can be 
individually selected. In the SPC setup window, all the channels for the application 
are listed in the field Highlight channels for SPC. If only the channel name is 
shown against a white background, the SPC check for that channel is disabled. This 
is the default situation.

To select a channel for SPC:

• In the Highlight channels for SPC field, click on the channel name. The 
name is highlighted and the value being checked is shown.

• Clicking further on the channel name takes you through the parameters. 
Figure 8.1 shows all the different parameters for which values can be 
checked.

8.3.3 Initializing the SPC Data File
After setting the parameters and selecting the required channels, you must save the 
changes and initialize the SPC data file. This enables the SPC module, which then 
collects all measurement results in the data file.

To initialize the SPC data file for that application:

• In the navigation/control area of the application window, click on the 
Save or OK buttons to save the new parameters and settings. A message is 
displayed informing you that the data file will be initialized.
NOTE: If you have entered a parameter value outside the permitted 

range, or entered a value that causes another field to be outside 
its permitted range, a warning message is displayed to inform 
you. Clicking on the OK button will highlight the affected 
check box.

• Click on the OK button to start the initialization.

The SPC module now collects measurement results in the data file. When sufficient 
results have been collected the SPC limits are calculated for all selected channels.
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8.4 CALCULATING SPC LIMITS
The SPC limits are calculated for each channel over a set number of values. The 
number of values used for limit calculation is set in the field Nr of values checked 
for limit recalculation in the SPC setup window. 

The total number of samples used in limit calculation depends on the number of 
groups, group size and whether or not the groups overlap.

The SPC limits are calculated as follows:

◆ The averages of the X- and R-values are calculated. These values are Xav 
and Rav.

◆ The standard deviations of the X- and R-values are calculated. These 
standard deviations may be either the actual standard deviations or 
estimated standard deviations based on the average of the R-values, Rav.
The standard deviations calculated here are used for the various checks 
involving sigma factors. The choice between real and estimated standard 
deviations for sigma checks is made in the SPC setup window.

◆ The control limits for the X- and R-values are calculated. These values are 
LCL(X), UCL(X), LCL(R) and UCL(R). These are set to be plus and 
minus 3-sigma from the averages. Again, actual or estimated standard 
deviations may be used to calculate these limits.
NOTE: It is normal to use the estimated standard deviations to 

calculate the control limits. But, you should use the same type 
of sigma calculations (real or estimated) for both the 
recalculation checks and for the control limits.

8.4.1 Initial Limit Calculation
Samples are accumulated in the SPC data file by measuring samples. As soon as 
enough samples are present in the data file, the SPC limits are calculated for all 
selected channels. The first sample in the data file marks the start of the first 
calculation group.

IMPORTANT: Many of the SPC functions are not available until enough samples 
are present in the data file and the SPC limits have been 
calculated.
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8.4.2 Automatic Limit Recalculation
Limit recalculation (Recal) will be automatically carried out for certain channels 
when the percentage of X- or R-values within 1-sigma of the average is not within 
the range specified in the SPC setup window.

When automatic recalculation occurs, the first sample in the control group is chosen 
by counting back through the stored results, by the number of samples set in the field 
Number of samples back to recal start, starting from the last sample.

NOTE: Limit recalculation of a channel is only possible if none of the SPC 
limits for that channel have been violated.

8.4.3 Manual Limit Recalculation
If the SPC limits are accurate and the results are normally distributed, then 
approximately two thirds of the X- and R-values should be within 1-sigma of their 
respective averages. If this is not the case, the limits should be recalculated.

You can manually recalculate the limits in the SPC values or SPC counters 
window.

To recalculate the limits:

• In the SPC Values or SPC Counters window, select the measuring 
channels you wish to recalculate in the grid.

• Click on the Recal button. An SPC message is displayed asking for the 
number of samples to use in the recalculation. The minimum number of 
samples required and the number of available files in the data file are 
shown in the window.
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Figure 8.2    SPC Message Window

• Enter the number of samples to use.

• Click on the OK button. The SPC module recalculates the limits using the 
number of files you have specified.

8.5 CHECKING SPC LIMITS
The SPC limit checks can be carried out on either or both of the X- and R-values. 
As sample results are received, X- and R-values are produced. These values depend 
on the group size, whether the groups overlap and whether the X-values are to be 
taken individually.

If X-values are to be taken individually, then an X-value is produced by every 
sample and the X-value is simply the result for the channel in question. If X-values 
are not taken individually, then an X-value is produced as each group of samples is 
completed and the X-value is the average over the group of the results for the 
channel in question.

An R-value is produced as each group of samples is completed and the R-value is 
the range over the group of the results for the channel in question (highest result in 
group minus lowest result in group).

If the groups overlap, then each group starts one sample after the start of the 
previous group and ends one sample after the end of the previous group. This means 
that every sample marks the end of a group and so X- and R-values are produced for 
every sample. In effect, the X-values are a moving average and the R-values are a 
moving range.
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If the groups do not overlap, then each group starts one sample after the end of the 
previous group. This means that if the group size is N, then every Nth sample marks 
the end of a group and so X- and R-values are produced after every Nth sample.

X-values limits are only checked when a new X-value is produced, and in the same 
way, R-values limits are only checked when a new R-value is produced. The next 
sections describe the checks on X- and R-values. If any limit is violated, a warning 
message is displayed.

8.5.1 Value Out of Limits
X-values are checked to see if they are within the control limits LCL(X) and 
UCL(X). R-values are checked to see if they are within the control limits LCL(R) 
and UCL(R).

NOTE: In many cases, LCL(R) is less than zero and is not checked because no 
R-value can be less than zero.

This check can be turned on and off individually for X- and R-values by checking 
or clearing the corresponding Check control limits check boxes.

8.5.2 Sequence of Increasing or Decreasing 
Values

The last few X- and R-values are checked to see if they have formed an increasing 
or decreasing series. The number of X- and R-values to be used for this check can 
be set in the field Max sequence increasing or decreasing. If the number to check 
is set to zero, the check is disabled.

8.5.3 Sequence of Values Above or Below the 
Average

The last few X- and R-values are checked to see if they are either all above the 
average or all below the average. The number of X- and R-values to be used for this 
check can be set in the field Max sequence above or below the mean. If the 
number to check is set to zero, the check is disabled.
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8.6 SPC VALUES
The results values, counters and the warnings can all be viewed in the SPC values 
windows. 

Three SPC values windows are available:

◆ SPC Values

◆ SPC Counters

◆ SPC Warnings

You can select which window to display by clicking on the related button at the top 
of the SPC values window.

The SPC module can be re-initialized from each of the three SPC values windows 
and channels can be recalculated from both the SCP Values and from the SPC 
Counters window.

The results for one or more channels can also be displayed graphically from these 
windows.

To open the SPC values windows:

• Select SPC > Open SPC values or click on the  button on the toolbar 
or in the navigation/control area of the application window. If the SPC 
values have been initialized, the values are displayed in the SPC Values 
window. If the SPC has not been initialized, the SPC Warnings window 
is displayed.

8.6.1 SPC Values Window
The SPC Values window displays all the values and limits calculated by the SPC 
module. This includes: the average and sigma values, the upper and lower limits and 
the number of samples since each channel was recalculated (Cal offs).

NOTE: In many cases LCL(R) is less than zero and is not checked because no 
R-value can be less than zero.
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Figure 8.3    SPC Values Window

8.6.2 SPC Graph Window
The calculated X- and R-values for both can be shown graphically in the SPC graph 
window. They are both shown on the same window with the X-values shown at the 
top.

Figure 8.4    SPC Graph Window
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The SPC graph window contains several fields and buttons for selecting and 
handling the channels in the graph..

8.6.3 SPC Counters Window
The SPC Counters window displays the counters used in the limits checking, for 
both X- and R-values. This includes % of values within the 1-sigma range, number 
of sequential increasing and decreasing values and the number of sequential values 
above and below the calculated averages.

Table 8-3 SPC Graph Window Fields and Buttons

Menu Item Function

Samples back Shows the position of the cursor on the graph.

X/R Shows the X- or R-value, depending on the cursor.

Grid Displays a grid on the graphs.

1,2,3-Sigma Displays the sigma values on the graphs.

Prints the graphs.

Tiles all open SPC graph windows.

Displays the graph of the previous channel.

Displays the graph of the next channel.

Displays the SPC Values window.
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Figure 8.5    SPC Counters Window

Any counter values that are outside the limits are shown in red. This gives a clear 
indication of any problems in addition to the information displayed on the SPC 
Warnings window.

8.6.4 SPC Warnings Window
The SPC Warnings window displays any warning message that is generated by the 
SPC module. A warning message is generated if the SPC module is not correctly 
initialized or any values are outside the limits.

Figure 8.6    SPC Warnings Window
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Chapter 9. Recalibration
9.1 INTRODUCTION
Recalibration is used for applications that were measured on a different Epsilon 3 
system and have to be used on the current Epsilon 3 system, or to refresh an existing 
calibration but using less standards.

9.2 CARRYING OUT A RECALIBRATION

• Copy the original application to the Epsilon 3 working directory.

• Open the application, in which you want to carry out a recalibration of 
standards or routine samples.

• In the application window, click on the  button. The recalibration 
program window is displayed.

Figure 9.1    Recalibration Program Window

• In the Recal. std. field, enter a new name for the recalibration standard.

• The field Measurement time factor is used to multiply the application 
measurement time with a factor to improve the counting statistics. The 
default value is “2”.
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• Click on the  button. The Add recalibration standards window is 
displayed.

Figure 9.2    Add Recalibration Standards Window
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The Add recalibration standards window has three main sections:

Both standards and unknown (routine) samples can be used as recalibration 
standards. When one of the samples in the upper or the middle part (Standards that 
have been measured or Recent unknown (routine) samples) is highlighted, the 
concentrations of this sample are shown in the lower part (Selected sample 
composition).

To add a selected sample to the recalibration program:

• Highlight the sample and click on the  button. The grid in the 
recalibration program window is automatically updated.

For one-point recalibration, only one sample is needed as a recalibration 
standard. In this case, only the E value is recalculated. When using more 
than 1 recalibration standard, then D and E values can be recalculated, 
where D is the intercept and E is the slope of the calibration line.

• Click on the Save button to save the recalibration program window.

To measure the recalibration standards in the recalibration program:

• Highlight the standard and click on the  button.

• The recalibration standards can also be measured by clicking on the  
button, which displays the measure sample window. 

Standards that have been measured Lists the standards that have been measured 
on the original Epsilon 3.

Recent unknown (routine) samples Lists the unknown (routine) samples 
measured on the original Epsilon 3 system.

Selected sample composition Displays the concentration of the highlighted 
sample or standard.
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Figure 9.3    Measure Sample Window

• Specify the sample type as Recal standard and click on the Measure 
button. 

• By default, the E value is recalculated automatically. After the 
recalibration measurements are finished, the Recalibration results 

window is displayed. Click on the  button to close the window.

• If both D and E values must be recalibrated, click on Calculate button to 
open the Recalibration results window.

Figure 9.4    Recalibration Calculation Window - Highlighted D Value
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• Highlight the row D value and click on  button. These parameters are 
now indicated by a “?” 

Figure 9.5    Recalibration Calculation Window Before Recalculation

• Click on  button to carry out the calculation. The original and the new 
D and E values are shown in the Recalibration calculation window.

• Click on the Accept button to save the results. From now on, every time 
after the recalibration standard measurements are finished, the D and E 
values will be recalculated automatically.

In case of transferring a calibration from another system to the current system, it is 
recommended to measure a few standards as unknown to validate the recalibration 
before analyzing routine samples.

In case of refreshing an existing calibration on the current system, it is 
recommended to measure a check sample to validate the recalibration before 
analyzing routine samples.
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Chapter 10. Automatic Program Selection (APS)
10.1 INTRODUCTION
Automatic Program Selection (APS) gives you the ability to use a short 
measurement program that measures a few key elements, after which the software 
automatically selects the appropriate application.

10.2 SETTING UP AUTOMATIC PROGRAM 
SELECTION

• Create a new application as a base application for APS.

Figure 10.1    New Application Window

• Fill in the name of the base application and press the Create New button. 
The APS application window is displayed.
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Figure 10.2    APS Application Window

• Using intensity criteria, select the elements that APS has to check for.

• Include a measurement condition and short measuring time for each 
element.

• Click on the OK button to save the application.

• Click on the Program Selection button to open the APS automatic 
program selection window.
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Figure 10.3    APS Automatic Program Selection Window with Intensity Criteria

10.3 ADDING AN APPLICATION IN THE APS 
WINDOW

• Select an application from the drop-down list and click on the  button.

• Enter the upper and lower limits of the count rate for each of the selected 
applications into the grid.

• Save the criteria by clicking on the OK button.

NOTES: a. Lower and/or upper intensity criteria can be set for one or more 
elements.

b. APS will select a certain application when all criteria for that 
specific application are fulfilled.

c. When no criteria are set for a certain application, that application 
will be used.

d. The order of the applications listed in the APS automatic program 
selection window is important. The software will scan the list of 
applications from top to bottom and the first application that fulfills 
all criteria will be used for measuring the unknown sample.

e. The order of the applications in the list can easily be changed by 
drag and drop of the application name to the appropriate place in the 
grid.
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10.4 CARRYING OUT AN APS MEASUREMENT

• In Measure application window, select the base application that will be 
used for APS and click on the OK button. The Measure sample window 
is displayed.

• Enter the name of the routine sample and click on the Measure button.

10.5 VIEWING THE RESULTS
The result of the APS measurement (checking which application to use) is visible in 
the APS results window of the APS application.

In this window, the name of each sample is extended with the name of the 
application that is used to quantify this sample. The actual result of the unknown 
sample is visible in the APS results window of that specific application.

Figure 10.4    APS Results Window
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Chapter 11. Enhanced Data Security
11.1 INTRODUCTION
The Enhanced Data Security is an optional extension to the Epsilon 3 software. 

Changing the Enhanced Data Security configuration is restricted to users with a 
sufficient privilege level (configurable via the User administration window).

11.2 ENHANCED DATA SECURITY FEATURES

11.2.1 Enhanced Data Security Configuration 
Window

To open the Enhanced data security configuration window:

• Select System > Enhanced data security.

NOTE: This menu item is not available when you have not installed the 
Enhanced data security software option.

Figure 11.1    Enhanced Data Security Configuration Window

The  button will generate a report with the data present in this form.
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11.2.1.1 Enable User Administration

User administration is designed to work in a windows network environment.
The user that started the Epsilon 3 software and checked the Enable user 
administration check box in the Enhanced data security configuration window 
becomes automatically the active user and gets the full access rights in the User 
administration window. The (PC) user name is shown on top of the main window.

These access rights can be changed in the User administration window.
The User administration window can also be used to add, modify and delete users 
to comply with the Enhanced data security regulations.

NOTE: If the Enable user administration check box is checked in the 
Enhanced data security configuration window, at least one user must 
be added to the user administration with both Active set to True AND 
User admin set to True.
If not, logging off the Epsilon 3 software will no longer allow you to 
login again!

Figure 11.2    User Administration Window

11.2.1.2 User Signing

When User signing is checked, the user has to sign each time via the Set signature 
window at the following trigger moments that generate or change result data:

◆ Start measurement
Start a manual measurement via the Measure window, the Measure 
Omnian sample window or the easy measure window.
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◆ Abort measurement
Abort a measurement via the Manual control window.

◆ Start batch measurement
Start a sample changer list via the Measure window.

NOTE: The check box User signing can only be checked when User validation 
via operation system is switched on.

Note that it is not possible to change a running batch when the user signed for it.

All actions which lead to new/altered results are also stored in the Message window.

Figure 11.3    Set Signature Window

11.2.1.3 Use Extended Transmission for Result Archiving

Although Use of extended transmission for result archiving is not actually a part 
of the Enhanced Data Security, it is related/linked to other Enhanced Data Security 
features and therefore can be modified only via the Enhanced data security 
configuration window when the Enhanced Data Security option is licensed 
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11.2.1.4 Allow Offline Measurement

When Allow offline measurement is checked, the Offline input window is 
displayed.

11.2.2 Editing of Measurement Results
When the check box Enable user administration is checked on the Enhanced 
data security configuration window, it is not possible for the active user to edit the 
measurement results. This feature can be switched on and off by checking or 
clearing the check box.

NOTE: Editing of measurement results is always possible but the 21 CFR Part 
11 (see Section 11.2.4) requires that dates are accompanied with time 
zone information and signature.

When Enable user administration is checked, this involves the following actions 
on the Results window:

◆ Recalculating the selected results
Clicking on the Recalculate button on the Results window will display a 
warning message and the action will not be executed.

◆ Editing a sample ident
Clicking on the Edit sample ident button on the Results window will 
display a warning message and the action will not be executed.

◆ Deleting results
Clicking on the Delete button on the Results window will display a 
warning message and the action will not be executed.

11.2.3 Time zones
21 CFR Part 11 (see Section 11.2.4) requires that dates are accompanied with time 
zone information.

21 CFR Part 11 supports the way in which Windows® handles time zones as an 
offset to Coordinated Universal Time (UTC), formerly called Greenwich Mean 
Time (GMT).

NOTE: The clock goes forward and backward for daylight saving time but UTC 
remains the same all year around. 
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An offset to UTC is therefore often presented as “UTC+/-<HH:MM>”, where 
<HH:MM> represents the current offset from UTC in 24-hours notation.

As an example, consider the time zone at PANalytical Almelo, The Netherlands. 
When standard time is active, the time zone representation will be “UTC+01:00”. 
During daylight saving time, the time zone representation will be “UTC+02:00”.

NOTE: Some countries in the world have times off by less than one hour, e.g. 
half an hour or even a quarter of an hour!

You should adjust the clock of your computer when daylight saving time changes.

When Enhanced data security is enabled, the time zone is added to the Results 
database. For existing results it is impossible to obtain this number afterwards.

The time zone (UTC) and User name will be shown as extra fields on the following 
windows:

◆ Results window

◆ Results spectra window

◆ Results report window (printout)

◆ Result graph report window (printout)

11.2.4 21 CFR Part 11 Support
The United States of America’s Food and Drug Administration (FDA) have issued 
regulations relating to the use of electronic records and electronic signatures. These 
requirements (21 CFR Part 11) have implications for the pharmaceutical and related 
industries and their suppliers. The processes in the pharmaceutical industry should 
be 21 CFR Part 11 compliant and PANalytical X-ray analysis products should 
support such processes.

• In order to comply with the 21 CFR Part 11 regulations with respect to the 
handling of results, ALL check boxes in the Enhanced data security 
window must be checked.
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Chapter 12. Off-line Operation
12.1 INTRODUCTION
Sample measurements can be simulated using the Offline status window, see 
Figure 12.1. This allows the intensities normally produced by measuring a sample 
to be entered from file(s). The data entered is then processed exactly as if it is from 
a measured sample.

This method can be used to simulate measurements of: routine samples and 
calibration standards.

The Offline status window is only available when the spectrometer is off-line, i.e. 
not connected to the PC, not switched on or the software has released the 
communication connection between the PC and the spectrometer.

12.2 OFF-LINE MEASUREMENTS
The measurement of routine and calibration samples can be simulated in the Offline 
status window. This is done by attempting to carry out the measurement as normal. 
Then, when normally the spectrometer would be measuring the sample, the Offline 
status window is displayed, allowing you to enter the simulated results.

Figure 12.1    Offline Status Window
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12.2.1 Starting an Off-line Measurement
NOTE: Measurements must have been exported before starting an off-line 

measurement.

The navigation buttons displayed at the top of the Offline status window will vary 
according to the type of measurement being carried out: routine or calibration.

To simulate a routine sample measurement:

• Click on the  toolbar button or select Application > Open 
application.

• Select the required application from the list and click on the OK button.

• In the navigation/control area of the application window, click on the 

 button. The measure sample window of the current application is 
opened.

• In the Sample ident field, enter the name of the sample.

• Click on the Measure button to start the measurement. The Offline status 
window is displayed, showing details of the application and sample.

Figure 12.2    Offline Status Window
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12.2.2 Carrying Out an Off-line Measurement
To enter the simulated intensities:

• Click on the  button and find the required MPS or SPI file.

• Click on the  button to fix the value in the field.

• Repeat this operation for each condition.

NOTE: The conditions of the spectra in the files must match those of the 
application. Also, you must specify a file for all conditions in the 
application.

• Click on the OK button

• If the application is set for a sequence of measurements, the sequence 
number increments and you are required to enter the data for the next 
measurement. This is repeated until the sequence is completed.

• When clicking on the OK button after the final measurement in the 
sequence, the software calculates the results and displays the results in the 
Offline measurement window.
NOTE: You have to enlarge the window to see the full results.

• For any channel you did not enter data for, the message No intensity is 
displayed.

The results of an off-line measurement are treated in exactly the same way as the 
results for a normal measurement. This means that the results can be viewed in the 
Last result window and the results are stored in the results database file for that 
application. These results can be recovered and displayed like any normal 
measurement results.

12.2.3 Cancelling an Off-Line Measurement
An off-line measurement can be cancelled at any moment by clicking on the Abort 
button.

Each measurement must be either completed or cancelled before any other 
measurement can take place. If you attempt to start another measurement before the 
current measurement is complete, a warning message is displayed informing you the 
current measurement is still in progress.
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Chapter 13. Tips for Setting Up Measuring Conditions
13.1 INTRODUCTION
This chapter gives some hints about setting up conditions (measurement parameters: 
voltage, current, filter, medium and time). It is assumed that you are familiar with 
the theory of X-ray emission in general (absorption edges, line energies etc.).

We do not attempt to provide the ‘one and only’ way to find the best conditions for 
an application, nor to discuss the subject in detail. We are just giving hints and some 
background information about why you should try a certain way.

13.2 DEFINING THE PROBLEM
With regard to measuring conditions there are basically two types of problems:

1. Setting up an application to measure samples with known elements.

2. Setting up an application to measure unknown samples.

Up to a certain point, both problems can be handled in the same way.

However, in the first case you may decide to ignore certain features in the spectrum 
because it is of no interest to the problem (for example process control).

In the second case the fine tuning of the conditions may be a long and tedious job.

Furthermore, for a known sample, one of the elements may be present in a very low 
concentration, such that special care must be taken to detect it.

In general, the problem is that you need to ‘see’ the spectral lines with a good signal-
to-noise ratio.

13.3 SIGNAL-TO-NOISE RATIO
If you have a line with a low signal-to-noise ratio you can improve it by:

1. Increasing the intensity of the primary X-rays.

2. Increasing the measuring time.

3. Averaging several measurements of the same sample.

13.3.1 Increasing the Intensity
You can increase the intensity of the primary X-rays by increasing the power 
applied to the X-ray tube (up to the tube limits). Normally this is done by increasing 
the current, as the voltage is usually set to a pre-determined level in order to observe 
certain features (for example to excite certain elements) in the measured spectra.
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An important factor to be considered is the detector count rate. When you increase 
the current, the count rate increases. A potential negative effect is the peaks ‘shift’ 
towards the lower energies. Both these effects may degrade the results and should 
therefore be avoided.

13.3.2 Increasing the Measuring Time
You can decrease the effect of noise by increasing the measurement time. However, 
this cannot be done indefinitely as the noise is inversely proportional to the square 
root of the measurement time and the maximum useful measurement time is 
determined by the detector’s intrinsic noise.

13.3.3 Averaging Several Measurements of the 
Same Sample

You can measure the same sample several times and then average the results to 
reduce the effect of noise. This improves the signal-to-noise ratio by a factor of the 
square root of the number of times it is measured (for example, if you measure 10 
times, the improvement factor = √10).

13.4 SPECTRAL LINES
Once again, the main goal is to see spectral lines, either a certain few that you are 
specifically interested in, or all of the lines present in the sample. The remainder of 
this chapter will concentrate on that subject.

13.5 MANUAL MODE OR APPLICATION MODE
There are two ways that you can start a measurement in Epsilon 3 (see also Chapter 
5 and Chapter 7):

1. Using manual mode (see Section 5.3 and Section 7.3).

2. Using application mode.
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13.6 INSPECTING A SPECTRUM
If you do not have any prior knowledge about a certain condition to be used, put the 
sample in the sample changer and use manual mode. An example of a resulting 
spectrum is shown in Figure 13.1.

Figure 13.1    Sample Spectrum - First Try

You can see a strong line at 2.8 keV that can be attributed to RhLα (from the X-ray 
tube). Other peaks are located near 8 keV due to CuKα, 8.6 keV due to ZnKα and 
19 keV due to RhKα.

Because the sample is a polymer standard, we know that it also contains Na, Mg, Al, 
Si, P, S, Ca and Ti. Deconvoluting the spectrum with all these lines shows where the 
lines of these elements are located in the spectrum. Please note that the signal-to-
noise ratio of those lines is too low to provide a reliable intensity value. To increase 
the signal-to-base ratio of these lines, we can do the following:

1. Using a filter for high energy lines.

2. Decreasing the voltage for low energy lines.
Page 13 - 5



Epsilon 3 Quick Start Guide
13.7 USING FILTERS
The effect of a filter is two-fold:

1. The overall intensity of the signal is decreased.

2. The ratio of high energy intensity to low energy intensity is increased.

The first effect is because X-ray photons are absorbed by the filter.

The second effect is because the absorption is not uniform over the whole spectral 
range. We want to find the optimum filter (the results show the lines that you want 
to see) and set the current high enough to get enough counts, but not too high.

One way to find out the best filter to use is to create an application with, for example, 
6 conditions. For each of the conditions, the voltage applied to the X-ray tube must 
be the same and the filters must be different. The current must be chosen such that 
the count rate is optimal. If you check the autocurrent check box, this is done 
automatically. 

Figure 13.2 shows a spectrum using the Ag filter. The same sample is shown in 
Figure 13.1, but without the filter. The measuring time was 100 s.

Figure 13.2    Sample Spectrum with Optimum Filter

Several low intensity lines are now visible in the energy region around Cu.
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To find out to which elements these lines belong:

• In the results spectra window, click on the  button to open the 
Elements and line groups window and then click on “Cu” in the periodic 
system.

• Use the right arrow to go through the elements in the periodic table 
(towards higher energies) and highlight the elements that match the lines.

• Finally perform another deconvolution.

13.7.1 Backscatter Bulge
For light elements there can be a high backscatter bulge in the spectrum, hiding low 
intensity lines. Figure 13.3 shows two spectrums, they are both of the same sample, 
but measured with two different tube voltages: 9 and 30 keV.

Figure 13.3    Backscatter Bulges

For both voltages, the backscatter bulge is visible. For 9 keV the complete 
backscatter bulge is visible, for the 30 keV most of it is visible. One of the elements 
to be measured from this sample is Cu. Theoretically, 9 keV is enough to show the 
Cu lines, but in this case it is better to change the voltage settings.
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13.8 Rh, Ar, Ag AND Mo LINES
It may occur that a spectrum shows lines from Rh, Ar, Ag and Mo. Although these 
elements can of course be present in the measured sample, this is not necessarily the 
case. In the Epsilon 3, the primary X-rays are generated in a Rh, Mo or Ag X-ray 
tube, thus these lines may be present.

For the other elements, the contribution is intrinsic to the hardware. These line 
intensities are normally very small. 

When using manual mode, these lines must be added manually. This is not 
necessary in the application mode. Figure 13.4 shows an example of a spectrum that 
contains Rh and Ar lines (from air) in the region from 2.8 to 3.2 keV.

Figure 13.4    Spectrum Containing Rh and Ar Lines

13.9 FIXED LINE RATIOS
The Epsilon 3 software contains a database with all measurable K, L, and M lines, 
including line ratios between the lines (for example between Kα and Kβ). This ratio 
is used when fitting the spectrum in the deconvolution step.

For the K lines this is mostly correct. However, for the L lines, the actual ratio in the 
spectrum may differ from the theoretical ratio. This means that when you fit a 
spectrum, the L line ratio must thus be a free parameter. This can be done by 
deselecting (greying) the L button in the periodic table and selecting (yellowing) the 
L1, L2, and L3 buttons.
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13.10 LIGHT ELEMENT ANALYSIS CONDITIONS
Elements in the range of Al to K can be measured in air or helium. When analyzing 
these elements in air, the precision may be worse because of variations in air 
pressure and temperature. When air pressure correction is switched on in the 
application, the instability is corrected by using the Al intensity of the gain 
measurement.
When measuring light elements Na to S in an analysis it is better to use helium 
because this obtains higher intensities.
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